User Guide

LMR Master™
S412E

An Integrated, Handheld Multi-function Land Mobile Radio Test Tool for Greater Flexibility and Technician Productivity

Appendix A provides a list of supplemental documentation for the LMR Master features and options. The documentation set is available as PDF files on the documentation disc and the Anritsu web site.
# Table of Contents

## Chapter 1—General Information

1-1 Introduction .................................................. 1-1
   Additional Documentation .................................. 1-1
   Contacting Anritsu for Sales and Service ............. 1-2
1-2 Instrument Description .................................... 1-3
   Frequency Ranges .......................................... 1-3
   Additional Options ........................................ 1-4
1-3 Instrument Care and Preventive Maintenance ....... 1-5
   Connector Care ............................................. 1-5
   ESD Caution ................................................ 1-6
1-4 Battery Replacement ....................................... 1-6
1-5 Calibration and Verification ............................ 1-8
1-6 Secure Environment Workplace ......................... 1-9
   LMR Master Memory Types ................................ 1-9
   Erase All User Files in Internal Memory ............ 1-9
   Recommended Usage in a Secure Environment .......... 1-10

## Chapter 2—Instrument Overview

2-1 Introduction .................................................. 2-1
2-2 Turning On the LMR Master ............................... 2-1
2-3 Front Panel Overview ...................................... 2-1
   Front Panel Keys .......................................... 2-3
   Touch Screen Keys ......................................... 2-6
   Keypad Menu Keys (1 to 9) ................................ 2-6
   LED Indicators ............................................. 2-6
2-4 Display Overview ............................................ 2-7
   Display Settings ........................................... 2-8
2-5 Test Panel Connector Overview ......................... 2-9
   Test Panel Connectors .................................... 2-10
2-6 Symbols and Indicators ................................... 2-11
   Battery Symbols .......................................... 2-13
   Additional Symbols ....................................... 2-14
2-7 Data Entry ................................................... 2-14
   Numeric Values .......................................... 2-14
   Parameter Setting ......................................... 2-14
   Text Entry .................................................. 2-15
2-8 Mode Selector Menu ....................................... 2-16
Chapter 3—Quick Start Guide

3-1 Introduction ................................................................. 3-1
3-2 Measurement Mode Selection ................................. 3-1
3-3 CW Signal Generator .................................................. 3-2
3-4 Vector Network Analyzer ........................................... 3-3
  Field Mode Display vs. Standard VNA Display ........ 3-3
  Select the Measurement Type. ................................. 3-4
  Set the Frequency ..................................................... 3-4
  Set the Scale ........................................................... 3-4
  Turn On Markers ....................................................... 3-4
  Peak and Valley Search Markers ............................. 3-4
  Set Up Delta Markers .................................................. 3-5
  Set a Single Limit Line ............................................... 3-5
  Set Up Distance Domain ............................................ 3-6
  Calibration Considerations ....................................... 3-6
3-5 Spectrum Analyzer ................................................... 3-9
  Set Start and Stop Frequencies ............................... 3-9
  Enter the Center Frequency .................................... 3-9
  Select a Signal Standard ............................................ 3-9
  Set the Measurement Bandwidth ............................... 3-9
  Set the Amplitude ...................................................... 3-10
  Power Offset Set Up for Compensating External Loss .... 3-10
  Set the Span ............................................................ 3-10
  Single Limit Line ....................................................... 3-11
  Create a Limit Envelope ........................................... 3-11
  Setting Up Markers .................................................... 3-12
  Select a Smart Measurement Type ......................... 3-13
3-6 NBFM Analyzer ......................................................... 3-14
  Set the Receiver (Rx) Frequency ............................. 3-14
  Set the Signal Source Transmit (Tx) Frequency ........ 3-14
  Rx and Tx Power Offset ............................................. 3-15
  Select the Measurement Types ................................. 3-15
3-7 LMR Digital Demodulation Signal Analyzers ............. 3-17
  Set the Receiver (Rx) Frequency ............................. 3-17
  Set the Signal Source Transmit (Tx) Frequency ........ 3-17
  Rx and Tx Power Offset ............................................. 3-18
  Select the Measurement Types ................................. 3-18
3-8 Saving Measurements ................................................ 3-23
### Table of Contents (continued)

3-9 External Power On .................................................. 3-24

#### Chapter 4—File Management

4-1 Introduction ....................................................... 4-1
4-2 File Types ......................................................... 4-1
4-3 Managing Files .................................................... 4-2
   Save Files ......................................................... 4-2
   Save Dialog Box .................................................. 4-3
   Quick Name Keys .................................................. 4-3
   Recall Files ....................................................... 4-4
   Recall Dialog Box ................................................ 4-4
   Copy Files ......................................................... 4-5
   Delete Files ....................................................... 4-6
   Delete Dialog Box ................................................ 4-6
4-4 File Menu Overview ............................................... 4-7
4-5 File Menu .......................................................... 4-8
   Save Menu ......................................................... 4-9
   Save Location Menu .............................................. 4-10
   Save On Event Menu ............................................. 4-11
   Recall Menu ....................................................... 4-12
   Copy Menu ........................................................ 4-13
   Delete Menu ....................................................... 4-14

#### Chapter 5—System Operations

5-1 Introduction ....................................................... 5-1
5-2 System Menu Group Overview ................................. 5-2
   System Menu Map 1 ............................................... 5-2
   System Menu Map 2 ............................................... 5-3
5-3 System Menu ........................................................ 5-4
5-4 Application Options Menu ....................................... 5-5
   VNA Mode ........................................................ 5-5
   SPA Mode ......................................................... 5-6
   DMR Mode ........................................................ 5-7
   P25 Mode ........................................................ 5-7
   P25p2 Mode ....................................................... 5-8
   NXDN Mode ....................................................... 5-8
   PTC Mode ........................................................ 5-9
   TETRA Mode ....................................................... 5-9
   Updating Signal Generator Patterns ......................... 5-10
Table of Contents (continued)

5-5 System Options Menu ........................................... 5-11
    System Options Menu ........................................... 5-11
    System Options 2/2 Menu ...................................... 5-12
    Power–On Menu .................................................. 5-14
    Display Settings Menu ......................................... 5-15
    Brightness Settings Menu ...................................... 5-16
5-6 Reset Menu ....................................................... 5-17
5-7 Preset Menu ...................................................... 5-18
5-8 Self Test .......................................................... 5-18
5-9 Updating the LMR Master Firmware ........................... 5-19

Chapter 6—Ethernet Connectivity
6-1 Introduction ....................................................... 6-1
6-2 Ethernet Connection ............................................. 6-1
    Network Connection ............................................. 6-1
    Ethernet Direct Connection .................................... 6-1
6-3 Ethernet Configuration .......................................... 6-2
    LAN Connection ................................................. 6-2
    Ethernet Config ................................................ 6-4
    Ethernet Menu .................................................. 6-5
6-4 DHCP ............................................................. 6-6
    Example 1 ......................................................... 6-7
    Example 2 ......................................................... 6-7
6-5 ipconfig Tool .................................................... 6-7
6-6 Ping Tool ........................................................ 6-8

Chapter 7—Anritsu PC Software Tools
7-1 Introduction ....................................................... 7-1
7-2 Anritsu Tool Box ............................................... 7-1
7-3 Line Sweep Tools ............................................... 7-2
7-4 Master Software Tools ......................................... 7-3
7-5 easyTest Tools .................................................. 7-4
7-6 easyMap Tools .................................................. 7-4

Chapter 8—Bias Tee (Option 10)
8-1 Overview ........................................................ 8-1
    Bias Tee in VNA Mode ......................................... 8-1
    Bias Tee in SPA Mode ......................................... 8-3
Table of Contents (continued)

**Chapter 9—GPS (Option 31)**
- 9-1 Introduction ................................................. 9-1
- 9-2 Activating the GPS Feature ............................. 9-1
- 9-3 Saving and Recalling Traces with GPS Information ................................. 9-3
  - Saving Traces with GPS Information .................. 9-3
  - Recalling GPS Information .............................. 9-3
- 9-4 GPS Menu .................................................. 9-3

**Chapter 10—Web Remote Control**
- 10-1 Introduction .................................................. 10-1
- 10-2 Setup ............................................................ 10-1
  - LAN Connection ............................................. 10-1
  - Connection to a Wi-Fi Portable Router ............... 10-2
- 10-3 Web Remote Control Interface ......................... 10-3
  - User Login .................................................... 10-3
  - Home Page .................................................... 10-4
  - Remote Control ............................................. 10-5
  - Capture Screen ............................................. 10-7
  - Capture Trace .............................................. 10-7
  - File List ..................................................... 10-8
  - Device Management (not as Administrator) ........ 10-8
  - Device Management (Administrator) ................ 10-11
  - Logout .......................................................... 10-13

**Appendix A—Measurement Guides**
- A-1 Introduction ................................................ A-1

**Appendix B—Error Messages**
- B-1 Introduction .................................................. B-1
- B-2 Reset Options ............................................... B-1
  - Reset Via Instrument Menus .......................... B-1
  - Reset from OFF Condition ............................ B-1
Table of Contents (continued)

B-3  Self Test ................................................................. B-2
  Application Self Test .................................................. B-3
  VNA Mode Self Test (Vector Network Analyzer mode only) .... B-3
  Spectrum Analyzer Mode Self Test ................................... B-4
  CW Signal Generator Mode Self Test ................................. B-4
  NBFM, P25/P25p2, NXDN, dPMR, DMR, PTC, and TETRA Self Test B-5

B-4  Operation Error Messages ......................................... B-6
  Fan Failure. ............................................................... B-6
  High Temp Warning ..................................................... B-6
  Operation not Permitted in Recall Mode ............................. B-7
  Power Supply ............................................................ B-7
  Error Saving File. General Error Saving File ...................... B-7

Appendix C—Tower Mounted Amplifiers
C-1  Introduction ........................................................... C-1

Appendix D—Glossary of Terms
D-1  Introduction ........................................................... D-1
D-2  Glossary of Terms ..................................................... D-1

Index
Chapter 1 — General Information

1-1 Introduction

The LMR Master User Guide is part of a set of manuals that cover all of the instrument functions and their use. This manual covers the instrument overview, system functions, and other common features, along with a brief guide to basic measurement concepts and setups. Most instrument operations and modes are covered in specific measurement guides as listed below.

Additional Documentation

<table>
<thead>
<tr>
<th>Document Part Number</th>
<th>Description (Required Option)</th>
</tr>
</thead>
<tbody>
<tr>
<td>10100-00065</td>
<td>Important Product Information, Compliance, and Safety Notices</td>
</tr>
<tr>
<td>10580-00289</td>
<td>Vector Network Analyzer Measurement Guide</td>
</tr>
<tr>
<td></td>
<td>VNA Bias-Tee (Option 10), Vector Voltmeter (Option 15)</td>
</tr>
<tr>
<td></td>
<td>Distance Domain</td>
</tr>
<tr>
<td>10580-00240</td>
<td>High-Accuracy Power Meter Measurement Guide (Option 19)</td>
</tr>
<tr>
<td>10580-00349</td>
<td>Spectrum Analyzer Measurement Guide</td>
</tr>
<tr>
<td></td>
<td>Interference Analyzer (Option 25), Channel Scanner (Option 27)</td>
</tr>
<tr>
<td></td>
<td>Coverage Mapping (Option 431), AM/FM/PM Analyzer (Option 509)</td>
</tr>
<tr>
<td></td>
<td>EMF Measurements (Option 444)</td>
</tr>
<tr>
<td>10580-00234</td>
<td>3GPP Signal Analyzer Measurement Guide</td>
</tr>
<tr>
<td></td>
<td>LTE RF Measurements (Option 541)</td>
</tr>
<tr>
<td></td>
<td>LTE Modulation Quality (Option 542)</td>
</tr>
<tr>
<td></td>
<td>LTE OTA Measurements (Option 546)</td>
</tr>
<tr>
<td></td>
<td>LTE 256QAM Demodulation Measurements (Option 886)</td>
</tr>
<tr>
<td></td>
<td>GSM/GPRS/EDGE Measurements (Option 880)</td>
</tr>
<tr>
<td></td>
<td>EMF Measurements (Option 444)</td>
</tr>
<tr>
<td>10580-00236</td>
<td>WiMAX Signal Analyzer Measurement Guide</td>
</tr>
<tr>
<td></td>
<td>Fixed WiMAX RF Measurements (Option 46)</td>
</tr>
<tr>
<td></td>
<td>Fixed WiMAX Demodulation (Option 47)</td>
</tr>
<tr>
<td></td>
<td>Mobile WiMAX RF Measurements (Option 66)</td>
</tr>
<tr>
<td></td>
<td>Mobile WiMAX Demodulation (Option 67)</td>
</tr>
<tr>
<td></td>
<td>Mobile WiMAX Over-the-Air Measurements (Option 37)</td>
</tr>
<tr>
<td>10580-00243</td>
<td>Land Mobile Radio Measurement Guide</td>
</tr>
<tr>
<td></td>
<td>NBFM Analyzer</td>
</tr>
<tr>
<td></td>
<td>P25/P25p2 Analyzer and Coverage (Options 521 and 522)</td>
</tr>
<tr>
<td></td>
<td>NXDN Analyzer and Coverage (Options 531 and 532)</td>
</tr>
<tr>
<td></td>
<td>dPMR Analyzer and Coverage Mapping (Options 573 and 572)</td>
</tr>
<tr>
<td></td>
<td>DMR Analyzer and Coverage (Options 591 and 592)</td>
</tr>
<tr>
<td></td>
<td>PTC Analyzer and Coverage (Options 721 and 722)</td>
</tr>
<tr>
<td></td>
<td>TETRA Analyzer and Coverage (Options 581 and 582)</td>
</tr>
<tr>
<td>11410-00486</td>
<td>LMR Master Technical Data Sheet</td>
</tr>
<tr>
<td></td>
<td>Performance Specifications, Instrument Options and Accessories</td>
</tr>
<tr>
<td>10580-00319</td>
<td>LMR Master SCPI Programming Manual</td>
</tr>
</tbody>
</table>
Read the Handheld Instruments Product Information, Compliance, and Safety Guide (PN: 10100-00065) for important safety, legal, and regulatory notices before operating the equipment. For additional information and literature covering your product, visit the product page of your instrument and select the Library tab:


**Contacting Anritsu for Sales and Service**

To contact Anritsu, visit the following URL and select the services in your region: [http://www.anritsu.com/contact-us](http://www.anritsu.com/contact-us).
1-2 Instrument Description

The S412E LMR Master is an integrated multi-functional test instrument that eliminates the need to carry and learn multiple test sets. The S412E combines a high performance receiver/spectrum analyzer with a vector network analyzer. The S412E can optionally be configured to include Coverage Mapping for P25/P25p2, NXDN™, dPMR, DMR MOTOTRBO™, ITC-R PTC, and TETRA (LMR Digital Demodulation). Other available options include Interference Analyzer with mapping, Channel Scanner, AM/FM/PM Analyzer, Vector Voltmeter, Fixed and Mobile WiMAX™, GSM/GPRS/EDGE, FirstNet LTE (RF, Modulations, and Over-the-Air), and High Accuracy Power Meter.

The S412E includes a CW and NBFM Signal Generator with a 500 kHz to 1.6 GHz frequency range and 0 dBm (1 mW) maximum power level. In many available LMR modes (P25/P25p2, NXDN, TETRA, DMR, or ITC-R PTC), the S412E signal generator can create mode-specific patterns, CW, 1 kHz AM, and 1 kHz FM signals with adjustable frequency and power levels.

The LMR Master spectrum analyzer, NBFM, P25/P25p2, NXDN, TETRA, DMR, dPMR, and PTC frequency ranges are expanded to 6 GHz with Option 6. The VNA frequency range is expanded to 6 GHz with Option 16. Additional options include a Bias Tee for TMA testing and a GPS receiver. Details on configuration and available options is provided in the LMR Master Technical Data Sheet.

The bright 8.4 inch TFT backlit LCD color display provides easy viewing in a variety of lighting conditions, and the combination of a touch screen and keypad enables you to navigate menus with the touch screen and to enter numbers with the keypad. All LMR Master models are equipped with a field-replaceable Li-Ion battery delivering more than three hours of battery life.

The internal memory is large enough to store approximately 2,000 traces or setups. External USB memory is limited only by the size of the attached USB memory device. Measurements and setups can also be stored in a USB flash drive or transferred to a PC by using the included USB cable or through Ethernet. Use Line Sweep Tools (LST) for certain VNA measurements and Master Software Tools (MST) for spectral analysis measurements (refer to Chapter 7, “Anritsu PC Software Tools” for a brief overview of these software tools).

| Note | Not all after-market USB flash drives are compatible with the LMR Master. Many drives come with a second partition that contains proprietary firmware. This partition must be removed. Only one partition is allowed. Refer to the individual manufacturer for instructions on how to remove it. Some drives can be made to work by reformating them using the FAT32 format. |

Frequency Ranges

Table 1.1 lists the LMR Master frequency ranges for the various measurement modes.

<table>
<thead>
<tr>
<th>Model</th>
<th>Frequency Range</th>
</tr>
</thead>
</table>
| S412E | Vector Network Analyzer: 500 kHz to 1.6 GHz<sup>a</sup>  
Spectrum Analyzer: 9 kHz to 1.6 GHz<sup>b</sup>  
Signal Generator: 500 kHz to 1.6 GHz  
NBFM Analyzer: 100 kHz to 1.6 GHz<sup>b</sup> |

<sup>a</sup> Upper frequency range is 6 GHz with Option 16.  
<sup>b</sup> Upper frequency range is 6 GHz with Option 6.
### Additional Options

Additional options for the LMR Master are listed in Table 1-2. Most of these options are described in Measurement Guides (refer to Appendix A).

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S412E-0006</td>
<td>6 GHz Spectrum Analyzer Frequency Extension</td>
</tr>
<tr>
<td>S412E-0010</td>
<td>Bias Tee</td>
</tr>
<tr>
<td>S412E-0015</td>
<td>Vector Voltmeter</td>
</tr>
<tr>
<td>S412E-0016</td>
<td>6 GHz VNA Frequency Extension</td>
</tr>
<tr>
<td>S412E-0019</td>
<td>High Accuracy Power Meter</td>
</tr>
<tr>
<td>S412E-0025</td>
<td>Interference Analyzer</td>
</tr>
<tr>
<td>S412E-0027</td>
<td>Channel Scanner</td>
</tr>
<tr>
<td>S412E-0031</td>
<td>GPS</td>
</tr>
<tr>
<td>S412E-0046</td>
<td>Fixed WiMAX RF Measurements</td>
</tr>
<tr>
<td>S412E-0047</td>
<td>Fixed WiMAX Demodulation</td>
</tr>
<tr>
<td>S412E-0066</td>
<td>Mobile WiMAX RF Measurements</td>
</tr>
<tr>
<td>S412E-0067</td>
<td>Mobile WiMAX Demodulation</td>
</tr>
<tr>
<td>S412E-0037</td>
<td>Mobile WiMAX Over-the-Air Measurements</td>
</tr>
<tr>
<td>S412E-0043</td>
<td>Coverage Mapping</td>
</tr>
<tr>
<td>S412E-0444</td>
<td>EMF Measurement (requires Anritsu isotropic antenna)</td>
</tr>
<tr>
<td>S412E-0501</td>
<td>Distance Domain (feature is standard with firmware V1.11 and later)</td>
</tr>
<tr>
<td>S412E-0509</td>
<td>AM/FM/PM Analyzer</td>
</tr>
<tr>
<td>S412E-0521</td>
<td>P25/P25p2 Analyzer Measurements</td>
</tr>
<tr>
<td>S412E-0522</td>
<td>P25/P25p2 Coverage Measurements</td>
</tr>
<tr>
<td>S412E-0531</td>
<td>NXDN Analyzer Measurements</td>
</tr>
<tr>
<td>S412E-0532</td>
<td>NXDN Coverage Measurements</td>
</tr>
<tr>
<td>S412E-0541</td>
<td>LTE RF Measurements</td>
</tr>
<tr>
<td>S412E-0542</td>
<td>LTE Modulation Quality</td>
</tr>
<tr>
<td>S412E-0546</td>
<td>LTE Over-the-Air Measurements</td>
</tr>
<tr>
<td>S412E-0886</td>
<td>LTE 256QAM Demodulation Measurements (requires Option 542)</td>
</tr>
<tr>
<td>S412E-0573</td>
<td>dPMR Analyzer RF Measurements</td>
</tr>
<tr>
<td>S412E-0572</td>
<td>dPMR Coverage Measurements</td>
</tr>
<tr>
<td>S412E-0591</td>
<td>DMR Analyzer Measurements</td>
</tr>
<tr>
<td>S412E-0592</td>
<td>DMR Coverage Measurements</td>
</tr>
<tr>
<td>S412E-0721</td>
<td>PTC Analyzer Measurements</td>
</tr>
<tr>
<td>S412E-0722</td>
<td>PTC Coverage Measurements</td>
</tr>
<tr>
<td>S412E-0581</td>
<td>TETRA Analyzer Measurements</td>
</tr>
<tr>
<td>S412E-0582</td>
<td>TETRA Coverage Measurements</td>
</tr>
<tr>
<td>S412E-0880</td>
<td>GSM/GPRS/EDGE Measurements</td>
</tr>
</tbody>
</table>
1-3 Instrument Care and Preventive Maintenance

LMR Master preventive maintenance consists of cleaning the unit and inspecting and cleaning the RF connectors on the instrument and on all accessories. Clean the LMR Master with a soft, lint-free cloth dampened with water or with water and a mild cleaning solution.

Caution To avoid damaging the display or case, do not use solvents or abrasive cleaners.

Connector Care

Clean the RF connectors and center pins with a cotton swab dampened with denatured alcohol. Visually inspect the connectors. The fingers of the N(f) connectors and the pins of the N(m) connectors should be unbroken and uniform in appearance. If you are unsure whether the connectors are undamaged, gauge the connectors to confirm that the dimensions are correct. Visually inspect the test port cable(s). The test port cable should be uniform in appearance, and not stretched, kinked, dented, or broken.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the Type-N connectors. The recommended torque is 12 lbf·in to 15 lbf·in (1.36 N·m to 1.70 N·m). Inadequate torque settings can affect measurement accuracy. Over-tightening connectors can damage the cable, the connector, the instrument, or all of these items.

Visually inspect connectors for general wear, cleanliness, and for damage such as bent pins or connector rings. Repair or replace damaged connectors immediately. Dirty connectors can limit the accuracy of your measurements. Damaged connectors can harm the instrument. Connection of cables carrying an electrostatic potential, excess power, or excess voltage can damage the connector, the instrument, or both.

Connecting Procedure

1. Carefully align the connectors. The male connector center pin must slip concentrically into the contact fingers of the female connector.
2. Push connectors straight together. Do not twist or screw them together. A slight resistance can usually be felt as the center conductors mate.
3. To tighten, turn the connector nut, not the connector body. Major damage can occur to the center conductor and to the outer conductor if the connector body is twisted.
4. If you use a torque wrench, initially tighten by hand so that approximately 1/8 turn or 45 degrees of rotation remains for the final tightening with the torque wrench. Relieve any side pressure on the connection (such as from long or heavy cables) in order to assure consistent torque. Use an open-end wrench to keep the connector body from turning while tightening with the torque wrench.
   Do not over-torque the connector.

Disconnecting Procedure

1. If a wrench is needed, use an open-end wrench to keep the connector body from turning while loosening with a second wrench.
2. Complete the disconnection by hand, turning only the connector nut.
3. Pull the connectors straight apart without twisting or bending.
ESD Caution

The LMR Master, like other high performance instruments, is susceptible to ESD damage. Coaxial cables and antennas can easily build up a static charge, which (if allowed to discharge by connecting directly to the LMR Master without first discharging the static charge) may damage the instrument input circuitry. Operators must be aware of the potential for ESD damage and must take all necessary precautions.

Operators should exercise practices outlined within industry standards such as JEDEC-625 (EIA-625), MIL-HDBK-263, and MIL-STD-1686, which pertain to ESD and ESDS devices, equipment, and practices. Because these standards apply to the LMR Master, Anritsu Company recommends that any static charges that may be present be dissipated before connecting coaxial cables or antennas to the LMR Master. This may be as simple as temporarily attaching a short or load device to the cable or antenna prior to attaching to the LMR Master. Remember that the operator may also carry a static charge that can cause damage. Following the practices outlined in these standards helps to ensure that a safe environment exists for both personnel and equipment.

1-4 Battery Replacement

The battery can be replaced without the use of tools. The battery compartment is located on the lower left side of the instrument (when you are facing the measurement display). Refer to Figure 1-1. To remove the battery:

1. Slide the catch toward the bottom of the instrument.
2. Tilt the top of the door away from the unit.
3. Lift out the battery door.
4. Remove the battery pack from the instrument by grabbing the battery lanyard and pulling out.

Replacement is the opposite of removal. The battery key side (slot below the contacts) must be facing the front on the unit and slides in first. Press the battery inward firmly to seat the contacts, then reinstall the door.

| Note | When inserting the battery, the battery label must face the back of the instrument, and the guide slot on the battery must be below the contacts. If the battery door does not latch closed, the battery may be inserted incorrectly. |
The battery that is supplied with the LMR Master may need charging before use. The battery can be charged while it is installed in the LMR Master by using either the AC-DC Adapter or the DC adapter, or outside the LMR Master with the optional Dual Battery Charger. Refer to “Battery Symbols” on page 2-13 for a description of battery symbols.

**Note**

Use only Anritsu Company approved batteries, adapters, and chargers with this instrument.

Anritsu Company recommends removing the battery for long-term storage of the instrument.

**Caution**

When using the Automotive Cigarette Lighter Adapter, always verify that the supply is rated for a minimum of 60 Watts at 12 VDC, and that the socket is clear of any dirt or debris. If the adapter plug becomes hot to the touch during operation, then discontinue use immediately.
1-5 Calibration and Verification

The LMR Master is a field portable unit operating in the rigors of the test environment. In order to ensure measurement accuracy, RF calibration (OSLT, for example) must be performed prior to making a measurement in the field.

The LMR Master has no field-adjustable components. The RF calibration components, however, are crucial to the integrity of the calibration and must be periodically verified to ensure their performance. This is especially important if the components have been dropped or over-torqued.

| Note | For best calibration results (compensation for all measurement uncertainties), ensure that the calibration is performed at the end of the test port or optional extension cable (that is, at the same point that the device that is to be tested (DUT) will be connected). |

| Caution | For best results, use an Anritsu phase stable Test Port Extension Cable, such as those listed in the Technical Data Sheet for your instrument (refer to Appendix A). Use of a typical laboratory cable to extend the LMR Master test port to the device under test, or any bending of the cable subsequent to the OSL or OSLT calibration, may cause uncompensated phase reflections inside the cable. Reflections of this type cause measurement errors, which are more pronounced at higher frequencies. |

Anritsu recommends an annual calibration and performance verification of the LMR Master and the OSL calibration components and InstaCal module by local Anritsu service centers.

The LMR Master is self-calibrating and has no field-adjustable components. The OSL calibration components are crucial to the integrity of the calibration. As a result, they must be verified periodically to ensure performance conformity. This is especially important if the OSL calibration components have been accidentally dropped or over-torqued. Contact information for Anritsu Service Centers is available at http://www.anritsu.com/contact-us.
1-6 Secure Environment Workplace

This section describes the types of memory in the LMR Master, how to delete stored user files in internal memory, and recommended usage in a secure environment workplace.

LMR Master Memory Types

The instrument contains non-volatile disk-on-a-chip memory, EEPROM, and volatile DRAM memory. The instrument does not have a hard disk drive or any other type of volatile or non-volatile memory.

Disk-On-A-Chip (DOC)

DOC is used for storage of instrument firmware, factory calibration information, user measurements, setups, and *.jpg screen images. User information stored on the DOC is erased by the master reset process described in section “Erase All User Files in Internal Memory” on page 1-9.

EEPROM

This memory stores the model number, serial number, and calibration data for the instrument. Also stored here are the user-set operating parameters such as frequency range. During the master reset process, all operating parameters that are stored in the EEPROM are set to standard factory default values.

RAM Memory

This is volatile memory used to store parameters needed for the normal operation of the instrument along with current measurements. This memory is reset whenever the instrument is restarted.

External USB Flash Drive (not included with the instrument)

This memory may be selected as the destination for saved measurements and setups for the instrument. You can also copy the contents of the internal disk-on-chip memory to the external flash memory for storage or data transfer. The external USB flash drive can be reformatted or sanitized using software on a PC.

Refer to the Chapter 4, “File Management” for additional information on saving and copying files to the USB flash drive.

Erase All User Files in Internal Memory

Perform a Master Reset:

1. Turn the instrument on.
2. If the Menu screen is displayed, press the Esc key.
3. Press the Shift button then the System (8) button.
4. Press the System Options submenu key.
5. Press the Reset key, then the Master Reset key.
6. A dialog box is displayed on the screen warning that all settings will be returned to factory default values and all user files will be deleted.
7. Press the ENTER button to complete the master reset.
8. The instrument reboots, and the reset is complete.
Recommended Usage in a Secure Environment

Set the LMR Master to save files to an external USB flash drive:

1. Attach the external Flash drive and turn on the instrument.
2. Press the Shift button then the File (7) button.
3. Press the Save submenu key.
4. Press the Change Save Location submenu key, then select the USB flash drive with the rotary knob, Up/Down arrow keys, or the touchscreen.
5. Press the Set Location submenu key.

The external USB flash drive is now the default location for saving files.

**Note**

Not all after-market USB flash drives are compatible with the LMR Master. Many drives come with a second partition that contains proprietary firmware. This partition must be removed. Only one partition is allowed. Refer to the individual manufacturer for instructions on how to remove it. Some drives can be made to work by reformatting them using the FAT32 format.
Chapter 2 — Instrument Overview

2-1 Introduction

This chapter provides a brief overview of the Anritsu LMR Master. The intent of this chapter is to acquaint you with the instrument. For detailed measurement information, refer to a specific measurement guide listed in Appendix A, “Measurement Guides”.

2-2 Turning On the LMR Master

The Anritsu LMR Master is capable of approximately three hours of continuous operation from a fully charged, field-replaceable battery (refer to Section 1-4 “Battery Replacement” on page 1-6).

The LMR Master can also be operated from an external power source (which also simultaneously charges the battery). This can be achieved with either the Anritsu AC-DC Adapter or the Automotive Cigarette Lighter Adapter. Both items are included with the LMR Master.

To turn on the LMR Master, press the green On/Off button on the front panel (Figure 2-1). The LMR Master takes approximately sixty seconds to complete power warm-up and to load the application software. At the completion of this process, the instrument is ready for use.

2-3 Front Panel Overview

The LMR Master menu-driven interface is easy to use and requires little training. The LMR Master uses a touch screen and keypad for data input. The bottom menu keys and submenu keys on the right side are touch screen keys. The menu and submenu keys vary depending upon the selected mode of operation. Refer to “Mode Selector Menu” on page 2-16.

Numeric keys 1 through 9 are dual purpose, depending upon the current mode of operation. The dual-purpose keys are labeled with a number on the key itself, and the alternate function is printed in blue above each of the keys. Use the blue Shift key to access the functions that are printed on the panel. The Escape key, used for aborting data entry, is the oval button located above numeric key 9. The rotary knob, the four arrow keys, and the keypad can be used to change the value of an active parameter.

The Menu key provides graphical icons of all of the installed measurement modes and user defined shortcuts (refer to “Menu Key” on page 2-3). The locations of the keys are shown in Figure 2-1.
Note

Keep the fan inlet and exhaust ports clear of obstructions at all times for proper ventilation and cooling of the instrument.

---

1. Instrument Settings Summary (unique to each trace). Many of displayed settings are used as menu shortcuts. Select a setting using the touch screen to display the menu and set the parameter for editing.

2. Fan Exhaust Port

3. Speaker

4. Rotary Knob

5, 12. Fan Inlet Port

6. Touch Screen Submenu Keys

7. Menu Key

8. Enter Key and Arrow Keys

9. Esc (Escape) Key

10. Shift Key

11. Numeric Keypad and Shift Menu Keys (printed in blue above 1 through 9)

13. Charge LED

14. On/Off Button

15. Power LED

16. Touch Screen Main Menu Keys

Figure 2-1. LMR Master Overview
Front Panel Keys

Menu Key

Press this key to display a grid of shortcut icons for installed measurement modes and any user-selected menus and setup files that may have been added. **Figure 2-2** shows the **Menu** key screen with shortcut icons for the installed measurement modes. Touch one of the icons in the top row to change modes. These top-row icons are preinstalled and cannot be moved or deleted.

![Menu Key Screen, Icons for Installed Measurements](image)

**Figure 2-2.** Menu Key Screen, Icons for Installed Measurements

**Note**

The display of the Menu screen varies depending on your LMR Master model and installed options.

Only the **Esc** key and the touch screen icons are functional in the Menu screen. The instrument must be in a measurement mode to execute a function that is indicated in blue text above the number key. They do not function from the Menu screen.
Figure 2-3 shows the **Menu** key screen with shortcut icons for the installed measurement modes and four rows of user-defined shortcuts to menus and setup files.

Press and hold down any touch-screen key for a few seconds to add a shortcut to this screen. To add shortcut setup files (*.stp), open the recall menu and hold down on the file name for several seconds. Then select the location for the shortcut.

---

**Figure 2-3. Menu Key Screen with User-Defined Shortcuts**

User-defined shortcuts stay in memory until deleted. To delete or move a shortcut button, press the **Menu** key, then press and hold the shortcut for approximately 3 seconds. The **Customize Button** dialog box opens to allow a button to be deleted or moved. Press **Esc** to exit the Menu shortcut display.

---

**Note**

The Factory Default reset deletes all user created shortcut icons from the Menu screen. Refer to the “**Reset Menu**” on page 5-17 for additional information.
Help for the Menu shortcut screen is available by pressing the icon in the lower-right corner of the display.

**Figure 2-4.** Menu Help

**Esc Key**
Press this key to cancel any setting that is currently being made.

**Enter Key**
Press this key to finalize data input or select a highlighted item from a list.

**Arrow Keys**
The four arrow keys (around the Enter key) are used to scroll up, down, left, or right. The arrow keys can often be used to change a value or to change a selection from a list. This function is similar to the function of the rotary knob. The arrow keys are also used to move markers.

**Shift Key**
Pressing the Shift key followed by pressing a number key executes the function that is indicated in blue text above the number key. When the Shift key is active, its icon is displayed at the top-right of the measurement display area near the battery charge indicator.

**Figure 2-5.** Shift Key Icon
Number Keypad
The Number keypad has two functions: The primary function is number entry. The secondary function of the number keypad is to list various menus.

Rotary Knob
Turning the rotary knob changes numerical values, scrolls through selectable items from a list, and moves markers. Values or items may be within a dialog box or an edit window.

Touch Screen Keys

Main Menu Touch Screen Keys
These five main menu keys are horizontally arranged along the lower edge of the touch screen. The main menu key functions change to match specific instrument Mode settings. The main menu keys generate function-specific submenus. The various measurement modes are selected by pressing the Shift key and then the Mode (9) key. Descriptions of the various measurement modes can be found in the applicable Measurement Guides listed in Appendix A, “Measurement Guides”.

Submenu Touch Screen Keys
These submenu keys are arranged along the right-hand edge of the touch screen. The submenu key labels change as instrument measurement settings change. The current submenu title is shown at the top of the submenu key block.

Keypad Menu Keys (1 to 9)
Pressing the Shift key followed by pressing a number key selects the menu function that is printed in blue characters above the number key. Refer to Figure 2-1 on page 2-2.

Not all Secondary Function Menus are active in various measurement modes. If any one of these menus is available in a specific instrument mode of operation, then it can be called from the number keypad. It may also be available from a main menu key or a submenu key.

The Preset Menu (1) and System Menu (8) are described in Chapter 5, “System Operations”. The Sweep Menu (3), Measure Menu (4), Trace Menu (5), and Limit Menu (6) vary depending on measurement mode, refer to the Measurement Guides listed in Appendix A for information. The File Menu (7) is described in Chapter 4, “File Management”. The Mode Menu (9) is described in “Mode Selector Menu” on page 2-16.

LED Indicators

Power LED
The Power LED is located to the left of the On/Off key. The LED is solid green when the unit is on and slowly blinks when the unit is off but has external power.

Charge LED
The Charge LED is located to the right of the On/Off key. The LED slowly blinks when the battery is charging and is solid green when the battery is fully charged.
2-4 Display Overview

Figure 2-6 illustrates some of the key information areas of the LMR Master sweep window in Vector Network Analyzer mode using “Field” menu structure. For detailed information, refer to the Measurement Guides that are listed in Appendix A, “Measurement Guides”.

Figure 2-6. Field Mode View VNA Display with GPS On

1. Trace 1 (TR1) data (within Instrument Settings Summary)
2. Instrument Settings Summary (applies to all traces)
3. Real Time Clock
4. GPS Icon
5. GPS location
6. Battery Charge indicator
7. Measurement description
8. Submenu Touch Screen Keys
9. Main Menu Touch Screen Keys

Note

Refer to “Field Mode Display vs. Standard VNA Display” on page 3-3 for information on the two LMR Master menu structures in VNA mode.

Press Shift-8 (System) > Application Options > Meas Menu to toggle between the two structures.
Display Settings

In addition to the default color display, LMR Master offers the following display settings (System > System Options > Display) in some measurement modes:

- **Black on White** for printing and viewing in broad daylight conditions
- **Color on White** exchanges black for white on the display for best color printing
- **Night Vision** optimized for night-time viewing
- **High Contrast** for other challenging viewing conditions

![Default Colors](image1)

![Black on White](image2)

![High Contrast](image3)

![Color on White](image4)

![Night Vision](image5)

**Figure 2-7.** LMR Master Display Settings
2-5 Test Panel Connector Overview

Test panel connectors for the LMR Master S412E is shown in Figure 2-8.

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>External Reference In</td>
</tr>
<tr>
<td>2</td>
<td>Audio In</td>
</tr>
<tr>
<td>3</td>
<td>External Trigger In</td>
</tr>
<tr>
<td>4</td>
<td>Signal Generator Out</td>
</tr>
<tr>
<td>5</td>
<td>RF In</td>
</tr>
<tr>
<td>6</td>
<td>GPS Antenna (with Option 31)</td>
</tr>
<tr>
<td>7</td>
<td>USB Mini-B (Full Speed, USB 2.0)</td>
</tr>
<tr>
<td>8</td>
<td>RJ-45 LAN Connection</td>
</tr>
<tr>
<td>9</td>
<td>External Power</td>
</tr>
<tr>
<td>10</td>
<td>USB Type A (Full Speed, USB 2.0)</td>
</tr>
<tr>
<td>11</td>
<td>3.5 mm Headset Jack</td>
</tr>
<tr>
<td>12</td>
<td>VNA Port 1 50 ohm</td>
</tr>
<tr>
<td>13</td>
<td>VNA Port 2 50 ohm</td>
</tr>
</tbody>
</table>

Figure 2-8. Test Panel Connectors

**Note**

This instrument is equipped with Type N connectors. To prevent damage, do not use pliers or a plain wrench. Do not over tighten.

Recommended torque: 1.36 N·m to 1.70 N·m (12 lbf·in to 15 lbf·in).

Do not twist cable or accessory body. Rotate the coupling nut only.
Test Panel Connectors

External Power
The external power connector (refer to item “9” in Figure 2-8 on page 2-9) is used to power the unit and for battery charging. Input is 12 VDC to 15 VDC at up to 5.0 A. The green flashing Power LED indicates that the instrument has external power.

Warning
When using the AC-DC Adapter, always use a three-wire power cable that is connected to a three-wire power line outlet. If power is supplied without grounding the equipment in this manner, then the user is at risk of receiving a severe or fatal electric shock.

USB Interface – Type A
The LMR Master has two Type A USB connectors (refer to item “10” in Figure 2-8) that accept USB Flash Memory devices for storing measurements, setup data, screen images, and firmware updates.

USB Interface – Mini-B
USB 2.0 Mini-B connector (refer to item “7” in Figure 2-8) can be used to connect the LMR Master directly to a PC. The first time the LMR Master is connected to a PC, the normal USB device detection by the computer operating system will take place. The CD-ROM that is shipped with the instrument contains a driver for Windows XP that is installed when Master Software Tools is installed. Drivers are not available for earlier versions of the Windows operating system. During the driver installation process, place the CD-ROM in the computer drive and specify that the installation wizard should search the CD-ROM for the driver.

Note
For proper detection, either Line Sweep Tools or Master Software Tools should be installed on the PC prior to connecting the LMR Master to the USB port.

LAN Connection
The RJ-45 connector (refer to item “8” in Figure 2-8) is used to connect the LMR Master to a local area network or directly to a PC with an Ethernet crossover cable. Integrated into this connector are two LEDs. The amber LED shows the presence of a 10 Mbit/s LAN connection when on, and a 100 Mbit/s LAN connection when off. The green LED flashes to show that LAN traffic is present. For additional information about the LAN connection, Ethernet connection, and DHCP, refer to Chapter 6, “Ethernet Connectivity”.

Headset Jack
The headset jack provides audio output from the built-in AM/FM/SSB demodulator for testing and troubleshooting wireless communication systems. The jack accepts a 3.5 mm (1/8 inch) 3-wire miniature phone plug such as those commonly used with audio headsets (refer to item “11” in Figure 2-8).
External Trigger In
A TTL signal that is applied to the External Trigger In female BNC input connector causes a single sweep to occur. In the Spectrum Analyzer mode, it is used in zero span, and triggering occurs on the rising edge of the signal. After the sweep is complete, the resultant trace is displayed until the next trigger signal arrives (refer to item “3” in Figure 2-8).

External Reference In
The BNC female connector (refer to item “1” in Figure 2-8) is used for connection of an external frequency reference. The amplitude of the External Reference should be between –10 dBm and +10 dBm.

RF In (50 ohm)
This connector (refer to item “5” in Figure 2-8) provides the input 50 ohm interface for the Spectrum Analyzer function. With Option 10, Bias Tee, output is available on the center pin out of this port in Spectrum Analyzer mode.

GPS Antenna Connector (Option 31)
The GPS antenna connection on the LMR Master is type SMA-female (refer to item “6” in Figure 2-8). The GPS function is described in Chapter 9, “GPS (Option 31)”.

Audio In
Audio In (refer to item “2” in Figure 2-8) is used to support SINAD and Quieting measurements of analog FM radio sensitivity.

Signal Generator Out
Output of the built-in Signal Generator when the LMR Master is in CW, NBFM, P25/P25p2, NXDN, dPMR, DMR, TETRA, or PTC mode (refer to item “4” in Figure 2-8). Output is turned on with the Turn Sig-Gen ON main menu key.

VNA Port-1 (50 ohm)
This connector (refer to item “12” in Figure 2-8) provides the input/output 50 ohm interface for reflection measurements of the Vector Network Analyzer at Port 1.

VNA Port-2 (50 ohm)
This connector (refer to item “13” in Figure 2-8) provides the input 50 ohm interface for transmission measurements of the Vector Network Analyzer at Port 2. With Option 10, Bias Tee, output is available on the center pin out of this port in VNA mode.

2-6 Symbols and Indicators
The following symbols and indicators indicate the instrument status or condition on the display.
The instrument settings that are unique to each trace are summarized in an information block on the left side of the measurement display screen (refer to Figure 2-6). Each block contains the trace number followed by the S-parameter or information that is assigned to that trace (TR4: S21, for example). If the trace has Trace Math applied to it, then the math function is also displayed on that line (TR1: S11/M1, for example), where M1 is the memory that is associated with TR1, and the math function is Trace/Memory). The S-parameter that is assigned to the trace memory is shown (if enabled) at the top of each trace information block (M1: S11, for example). Each trace block also includes the Graph type, the smoothing percentage, the calibration status, and the scale (Resolution per Division and the Reference Value). The calibration status indicates whether the calibration is ON, OFF, or non-existent (--) for the specific S-parameter that is assigned to each trace. If the Calibration is ON, then its validity is also displayed (OK, ?, or X).

For calibration procedures refer to the Vector Network Analyzer Measurement Guide (PN: 10580-00289) listed in Appendix A.
Battery Symbols

The battery symbol above the display indicates the charge remaining in the battery. The colored section inside the symbol changes size and color with the charge level.

![Battery Status](image)

**Green with Black Plug body:** Battery is fully charged and external power is applied

**Green:** Battery is 30% to 100% charged

**Yellow:** Battery is 10% to 30% charged

**Red:** Battery 0% to 10% charged

**Lightning Bolt:** Battery is being charged (any color symbol)

Detailed battery information is also available in the Status dialog box (System > Status).

When either the AC-DC Adapter or the Automotive Cigarette Lighter Adapter is connected, the battery automatically receives a charge, and the battery symbol with the lightning bolt is displayed (Figure 2-10).

![Battery Charging Icon](image)

**Caution** Use only Anritsu-approved batteries, adapters, and chargers with this instrument.

When operating from external power without a battery installed, the battery symbol is replaced by a red plug body (Figure 2-11).

![Battery Not Installed](image)
Additional Symbols

Single Sweep
Single Sweep is selected. Press Continuous in the Sweep menu to resume continuous sweeping.

Floppy Icon
Shortcut to the Save submenu. Touch the icon to open the touch screen keyboard for saving measurements, setups, or screen displays.

---

2-7 Data Entry

Numeric Values
Numeric values are changed using the rotary knob, arrow keys, or the keypad. Pressing one of the main menu keys displays a list of submenus on the right side of the touch screen. When the value on a submenu key is displayed in red, it is ready for changing. When using the rotary knob or arrow keys the changing value is shown on the submenu and in red on the graticule. When using the keypad, the new value is shown in red on the graticule and the submenu changes to Units. Selecting a unit for the new value completes the entry.

Parameter Setting
Pop-up list boxes or edit boxes are used to provide selection lists and selection editors. Scroll through a list of items or parameters with the arrow keys, the rotary knob, or the touch screen. These list boxes and edit boxes frequently display a range of possible values or limits for possible values.

Finalize the input by pressing the Enter key. At any time before finalizing the input, press the escape (Esc) key to abort the change and retain the previously existing setting.

Some parameters (such as for antennas or couplers) can be added to list boxes by creating them and importing them using Master Software Tools.
Text Entry

When entering text, as when saving a measurement, the touch screen keyboard is displayed (Figure 2-13). Characters are entered directly with the touch screen keyboard. The keypad can be used for numeric entry. The left and right arrow keys scroll the cursor through the filename. Refer to “Save Menu” on page 4-9 for additional information.

Figure 2-13. Touch Screen Keyboard
2-8 Mode Selector Menu

To access the functions under the Mode menu, press the **Shift** key, then the **Mode** (9) key. Use the directional arrow keys, the rotary knob, or the touch screen to highlight the selection, and press the **Enter** key to select. The list of modes that appear in this menu varies depending upon the options that are installed and activated in the instrument. Figure 2-14 is an example of the Mode menu. Your instrument may not show the same list. The current mode is displayed below the battery symbol.

![Mode Selector Menu](image)

**Figure 2-14.** Mode Selector Menu

<table>
<thead>
<tr>
<th>MODE SELECTOR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vector Network Analyzer</td>
</tr>
<tr>
<td>Vector Voltmeter</td>
</tr>
<tr>
<td>Spectrum Analyzer</td>
</tr>
<tr>
<td>Power Meter</td>
</tr>
<tr>
<td>High Accuracy Power Meter</td>
</tr>
<tr>
<td>Interference Analysis</td>
</tr>
<tr>
<td>Channel Scanner</td>
</tr>
<tr>
<td>CW Signal Generator</td>
</tr>
<tr>
<td>AM-FM-PM Analyzer</td>
</tr>
<tr>
<td>LTE Signal Analyzer</td>
</tr>
<tr>
<td>Fixed WiMAX Signal Analyzer</td>
</tr>
<tr>
<td>Mobile WiMAX Signal Analyzer</td>
</tr>
<tr>
<td>NEFM Analyzer</td>
</tr>
<tr>
<td>DMR 2 Analyzer</td>
</tr>
<tr>
<td>P25 Analyzer</td>
</tr>
<tr>
<td>P25p2 Analyzer</td>
</tr>
<tr>
<td>NXDN Analyzer</td>
</tr>
<tr>
<td>PTC Analyzer</td>
</tr>
<tr>
<td><strong>TETRA Analyzer</strong></td>
</tr>
</tbody>
</table>

**Note** The display of the Mode Selector varies depending on installed options.

The **Menu** key is another option to quickly change measurement modes. Press the **Menu** key then select one of the Measurement icons in the top rows (Figure 2-2 on page 2-3).
2-9 Soft Carrying Case

The LMR Master can be operated while in the soft carrying case. On the back of the case is a large storage pouch for accessories and supplies.

To install the instrument into the soft carrying case:

1. The front panel of the case is secured with hook-and-loop fasteners. Fully close the front panel of the case. When closed, the front panel supports the shape of the case while you are inserting the LMR Master.

2. Place the soft carrying case face down on a stable surface, with the front panel fully closed and laying flat.

3. Open the zippered back of the case.

4. Insert the instrument face down into the case, take care that the connectors are properly situated in the case top opening. You may find it easier to insert the connectors first, then pull the corners over the bottom of the LMR Master.

5. Close the back panel and secure with the zipper to secure the LMR Master.

Note

The soft case has two zippers near the back. The zipper closer to the front of the case opens to install and remove the instrument. The zipper closer to the back of the case opens an adjustable support panel that can be used to provide support for improved stability and air flow while the instrument is in the case. This support panel also contains the storage pouch.

Figure 2-15. LMR Master Inserted into the Soft Carrying Case

Caution

The soft case has panel openings for the fan inlet and exhaust ports. Do not block the air flow through the panels when the unit is operating.
2-10 Tilt Bail Stand

A Tilt Bail is attached to the back of the LMR Master for desktop operation. The tilt bail provides two settings of backward tilt for improved stability. To deploy the tilt bail, pull the bottom of the tilt bail away from the back of the instrument. To store the tilt bail, push the bottom of the bail towards the back of the instrument until it attaches to the LMR Master.

| Note | Do not use the tilt bail while the instrument is in the soft case. The soft case has an adjustable support panel in the back zipper. |

Figure 2-16. Tilt Bail Extended
Chapter 3 — Quick Start Guide

3-1 Introduction

This chapter provides a brief overview of basic measurement setups for several measurement modes. For detailed measurement information, refer to a specific measurement guide listed in Appendix A, “Measurement Guides”. This chapter provides quick start measurement information for the following measurement modes:

- Section 3-3 “CW Signal Generator” on page 3-2
- Section 3-4 “Vector Network Analyzer” on page 3-3
- Section 3-5 “Spectrum Analyzer” on page 3-9
- Section 3-6 “NBFM Analyzer” on page 3-14
- Section 3-7 “LMR Digital Demodulation Signal Analyzers” on page 3-17

Note: LMR Digital Demodulation Signal Analyzers include P25/P25p2, NXDN™, dPMR, DMR, ITC-R PTC, and TETRA Signal Analyzers.

3-2 Measurement Mode Selection

Press the Menu key and use the touch screen to select the appropriate measurement icon.

![Menu Screen with Icons for Installed Measurement Modes](image)

Figure 3-1. Menu Screen with Icons for Installed Measurement Modes

Note: The display of the Menu screen varies depending on installed options.
3-3 CW Signal Generator

The CW Signal Generator provides a continuous wave (CW) signal from the Signal Generator Out port of the LMR Master. The CW signal is primarily used for testing the sensitivity of receivers. To test receiver sensitivity, connect the output directly to the receiver that is being measured, and then reduce the signal generator amplitude until the receiver is unable to detect the signal.

1. Set the instrument to CW Signal Generator mode as described in the previous section.
2. Press the Freq main menu key and set the transmit frequency of the CW signal.
3. Press the Amplitude main menu key and set the Power Level and Offset. Add a positive value offset value for any external gain or negative offset value for any external loss.
4. Press the Turn Sign-Gen OFF main menu key to stop transmitting.

Note

CW Output is turned on by default when entering CW Signal Generator mode and automatically turned off when exiting CW Signal Generator mode.

---

Figure 3-2. CW Signal Generator
3-4 Vector Network Analyzer

Set the instrument to Vector Network Analyzer (VNA) mode as described in Section 3-2.

Field Mode Display vs. Standard VNA Display

Field Mode is the default display of the LMR Master when the instrument is turned on for the first time or reset. Field Mode display may be more familiar to users who have experience making Cable and Antenna measurements using the Anritsu LMR Master. Standard VNA display allows the full Vector Network Analyzer functionality of the LMR Master.

Press Shift-8 (System) > Application Options > Meas Menu to toggle between the two views. Figure 3-3 shows an example of typical VNA measurements in Field Mode Display and Standard VNA display. Refer to the Vector Network Analyzer Measurement Guide listed in Appendix A for detailed information on VNA measurements and the menu differences between the two display structures.

![Field Mode Display vs. Standard VNA Display](image)

**Figure 3-3.** Measurement Menu in Field Mode Display and Standard VNA Display
Select the Measurement Type

Press the Measure main menu key and then the Measurement Type submenu key. Select a measurement graph and press Enter.

Set the Frequency

1. Press the Freq/Dist main menu key.
2. Press the Start Freq submenu key and use the keypad, rotary knob, or the arrow keys to enter the start frequency.
3. Press the Stop Freq submenu key and use the keypad, rotary knob, or the arrow keys to enter the stop frequency.

Set the Scale

1. Press the Scale main menu key.
2. For Smith Charts, select the appropriate zoom level. The graph expands or compresses around the central reference impedance of the Smith Chart
3. For other graphs, set the Top and Bottom of the scale or press Autoscale.

Turn On Markers

1. Press the Marker main menu key.
2. Press the Marker submenu key to open the Select Marker list box and select a marker by scrolling with the rotary knob or the arrow keys, then press Enter. Unused markers are labeled OFF. The number on the Marker submenu key indicates the active marker.
3. Use the rotary knob, arrow keys, or touch and drag to move the Marker. The frequency of the active Marker is shown in the upper-left corner of the display screen.

Peak and Valley Search Markers

When making measurements, the Peak Search and Valley Search features can be used to quickly place a Marker on a maximum or minimum point of a trace.

1. With an active marker, press the Peak Search or the Valley Search submenu key to find the maximum or minimum value on the trace that is associated with the current marker.
Set Up Delta Markers

If the intent is to conduct a delta measurement, then two markers are necessary: one to be the reference marker and one to be the delta marker.

**Delta Marker Setup:**

1. Press the **Marker** main menu key.
2. Turn on Marker 1 (to be the Ref marker) and assign it to a trace.
   a. Press **Marker** and select MK1 from the list box. Then press **Enter**.
   b. The **Marker Type** submenu key is set by default to **Ref**.
3. Turn on Marker 2 and change the **Marker Type** from **Ref** to **Delta**.
4. Assign Marker 2 to Marker 1 by pressing the **Avail Ref Mkr** submenu key to open the **Select One** list box. Scroll to choose **MK1** and press **Enter**.

**Note**
The Marker list box includes the current location, readout style, and delta status (if they exist). Otherwise, it indicates Off.

Set a Single Limit Line

1. Press **Shift** and then **Limit** (6) to enter the Limit menu.
2. Set **Limit State** to **On**. Press the **Limit** key to set the limit line to either **Upper** or **Lower**.
3. Use the numeric keypad, the arrow keys, or the rotary knob to change the limit value and then press **Enter**.

**Note**
Limit lines are not available for Smith charts.
Refer to the Vector Network Analyzer Measurement Guide (listed in Appendix A) for creating multi-segment limit lines.
4. Press the Limit Alarm key to turn on or off the Limit Alarm.

Figure 3-4. Single Limit Lines

Set Up Distance Domain

This option is fully described in the Vector Network Analyzer Measurement Guide. Refer to Appendix A, “Measurement Guides”. Measurement Guides are available on the documentation disc and as free downloads from the Anritsu Web site (refer to “Additional Documentation” on page 1-1).

Calibration Considerations

Various calibrations are available in the LMR Master. Press Shift-2 (Calibration) to open the calibration menu. Press Start Cal and follow the instruction onscreen. 1-Port calibration is the simplest and requires three connections during calibration. 2-Port calibration requires four calibration connections and corrects for the transmit port match.

VNA calibration requires external precision OSL calibration components. 2-Port calibration also requires a through connector (Figure 3-5 on page 3-7).

Note

The Vector Network Analyzer Calibration menu is the same one that is used in the Vector Voltmeter menu (Option 15). Refer to section “Calibration Menus” in Chapter 6 of the Vector Network Analyzer Measurement Guide (refer to Appendix A) for more information about the calibration menu. Note that some calibration parameters are shared between the Vector Network Analyzer and Vector Voltmeter mode, and that some parameters are different because they were optimized for the specific mode application.
When performing a calibration, the correction coefficients are calculated for specific measurements (depending on the type of calibration chosen) and for instrument settings (frequency range, number of points, and power level). The term “calibration correction” refers to the correction coefficients that are applied to measurements as a result of your calibration.

When calibration correction is On, the correction is applied to all applicable measurements. For example, if a 1-port calibration is performed, then only traces that measure reflection have a valid calibration. For those traces, the calibration information data in the Instrument Settings Summary (item 1 in Figure 2-6 on page 2-7) shows “CAL: ON (OK)”. Other traces that do not measure reflection display “CAL: --” to indicate that no valid calibration is available for those traces. The calibration correction can also be turned off manually under the Calibration menu by toggling the Cal Correction submenu key from On to Off. In that case, the display shows “CAL: OFF” for all traces that have valid correction data available.

Note that “CAL: OFF” means that a calibration correction has been created, but it is not currently being used. This is different from “CAL: --”, which means that no valid calibration correction is available for the current setting.
When you have Cal Correction on, you cannot increase the frequency range or the number of points. You can, however, reduce the frequency range or decrease the number of points without forcing the calibration to become invalid. When reducing the frequency range, the LMR Master uses the appropriate points within the new frequency range that have correction coefficients applied to them. In that case, you can observe that the number of points that are being used for calibration correction are automatically reduced.

If you reduce only the number of points, then the frequency range is not changed. The LMR Master finds a subset of the original points in the sweep that can be used. You can therefore notice that the instrument may not use the exact number of points that you have entered. It picks a specific number of points that allow the calibration correction to continue to be valid. If you use the rotary knob, you will more easily find the available number of points that can be set. For example, if you calibrated with 201 points, then you can observe that you can reduce the number of points to 101, 68, 51, 41, and so forth.

If you change the source power setting, the calibration status is changed to “CAL: ON (?P)”, which indicates that source power has changed since the instrument was calibrated (from Low to High, or from High to Low). In this case, the calibration may still be valid, but a new calibration is recommended.

Another status information display that you may see is “CAL: ON (?T)” which indicates that the instrument temperature has deviated by more than a set amount since the time that the calibration was conducted. The calibration is most likely still valid, but a new calibration is recommended. If you see “CAL: ON (X)” on the display, then this indicates that the instrument temperature has deviated (since the time the calibration was conducted) by an amount that has more than likely rendered the calibration invalid. When this occurs, a new calibration is highly recommended before further measurements are conducted.

Only one calibration is available at one time. Performing a new calibration overwrites any existing calibration. You can, however, store a measurement setup (with CAL), which also stores the calibration. You can therefore have multiple calibrations available (as long as the calibration settings and conditions continue to apply).

Existing Cal Info

The Cal Info submenu key is found in the Calibration main menu and lists the current calibration settings.
3-5 Spectrum Analyzer

Set the instrument to Spectrum Analyzer mode as described in Section 3-2 “Measurement Mode Selection” on page 3-1.

Note: The following Quick Start instructions apply to Spectrum Analyzer Mode. For detailed measurement instructions, refer to the Spectrum Analyzer Measurement Guide listed in Appendix A.

Set Start and Stop Frequencies

1. Press the Freq main menu key then the Start Freq submenu key.
2. Enter the desired start frequency using the keypad, the arrow keys, or the rotary knob. When entering a frequency using the keypad, the submenu key labels change to GHz, MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same affect as pressing the MHz submenu key.
3. Press the Stop Freq submenu key and enter the desired stop frequency.

Enter the Center Frequency

1. Press the Freq main menu key.
2. Press the Center Freq submenu key.
3. Enter the desired center frequency using the keypad, the arrow keys, or the rotary knob. When entering a frequency using the keypad, the submenu key labels change to GHz, MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same affect as pressing the MHz submenu key.

The center frequency and span is shown at the bottom of the screen.

Select a Signal Standard

1. Press the Freq main menu key.
3. Highlight a signal standard and press Enter to select.
4. Press the Channel submenu key to change the channel value in the Channel Editor.

The signal standard is shown in yellow at the top of the screen.

Set the Measurement Bandwidth

1. Press the BW main menu key to display the BW menu.
   - Press the RBW and/or the VBW submenu key to manually change the values.
   - Set RBW and VBW automatically by pressing the Auto RBW submenu key or the Auto VBW submenu key.
2. Press the RBW/VBW submenu key to change the resolution bandwidth to video bandwidth ratio.
3. Press the Span/RBW submenu key to change the span width to resolution bandwidth ratio.
Set the Amplitude

Press the **Amplitude** main menu key to display the Amplitude menu.

**Set Amplitude Reference Level and Scale**

1. Press the **Reference Level** submenu key and use the arrow keys, rotary knob, or the keypad to change the reference level. Press **Enter** to set the reference level value.

2. Press the **Scale** submenu key and use the arrow keys, rotary knob, or the keypad to enter the desired scale. Press **Enter** to set the scale value.

**Set Amplitude Range and Scale**

1. The **Auto Atten** submenu key sets an optimal reference level based on the measured signal.

2. Press the **Scale** submenu key.

3. Enter the desired scale units by using the keypad, the arrow keys, or the rotary knob. Press **Enter** to set. The y-axis scale is automatically renumbered.

**Power Offset Set Up for Compensating External Loss**

To obtain accurate results, compensate for any external attenuation by using power offset. In power offset mode, the compensation factor is in dB. (External attenuation can be created by using an external cable or an external high power attenuator.)

Press the **RL Offset** submenu key and use the keypad, the arrow keys, or the rotary knob to enter the desired offset value. When using the rotary knob, the value changes in increments of 0.1 dB. Using the **Left/Right** arrow keys changes the value in 10% increments of the value shown on the **Scale** submenu key. When using the **Up/Down** arrow keys, the value changes in the increment shown on the **Scale** submenu key. When using the keypad, enter the new value then press **Enter** or the **dB** submenu key to set the value. The power offset is displayed in the instrument settings summary column on the left side of the measurement display.

**Set the Span**

1. Press the **Span** main menu key or the **Freq** main menu key followed by the **Span** submenu key.

2. To select full span, press the **Full Span** submenu key. Selecting full span overrides any previously set Start and Stop frequencies.

3. For a single frequency measurement, press the **Zero Span** submenu key.

| Note | To quickly move the span value up or down, press the Span Up 1-2-5 or Span Down 1-2-5 submenu keys. These keys facilitate a zoom-in, zoom-out feature in a 1-2-5 sequence. |
Single Limit Line

Press the Limit menu key to display the Limit menu.

1. Press the Limit (Upper / Lower) submenu key to select the desired limit line, Upper or Lower.

2. Activate the selected limit line by pressing the On Off submenu key so that On is underlined.

3. Press the Limit Move submenu key to display the Limit Move menu. Press the first Move Limit submenu key and use the arrows keys, rotary knob, or keypad to change the dBm level of the limit line.

4. Press the Back submenu key to return to the Limit menu.

5. If necessary, press the Set Default Limit submenu key to redraw the limit line in view.

Create a Limit Envelope

1. Press Shift then Limit (6) to open the Limit menu.

2. Press Limit Envelope.

3. Press the Create Envelope key.

Figure 3-6. Limit Envelope
Setting Up Markers

Press the **Marker** main menu key to display the Marker menu.

Selecting, Activating, and Placing a Marker

1. Press the **Marker** submenu key and then select the desired marker by using the touch screen marker buttons. The selected marker is underlined on the **Marker** submenu key.

2. Press the **On Off** submenu key so that **On** is underlined. The selected marker is displayed in red and ready to be moved.

3. Use the rotary knob to place the marker on the desired frequency.

4. Repeat Step 1 through Step 3 to activate and move additional markers.

Selecting, Activating, and Placing a Delta Marker:

1. Press the **Marker** submenu key and select the desired delta marker. The selected marker is underlined.

2. Press the **Delta On Off** submenu key so that **On** is underlined. The selected marker is displayed in red and ready to be moved.

3. Use the rotary knob to place the delta marker on the desired frequency.

4. Repeat Step 1 through Step 3 to activate and move additional markers.

Viewing Marker Data in a Table Format

1. Press the **More** submenu key.

2. Press the **Marker Table On Off** submenu key so that **On** is underlined. All marker and delta marker data are displayed in a table under the measurement graph.

---

**Figure 3-7. Marker Table**
Select a Smart Measurement Type

In Spectrum Analyzer mode, press Shift then Measure (4) and select a smart one-button measurement using the submenu keys. The smart one-button measurements are built-in for field strength, occupied bandwidth, channel power, adjacent channel power ratio, and carrier to interference ratio (C/I) tests. In addition, AM/FM demodulation is available to aid in the identification of interfering signals. Refer to the Spectrum Analyzer Measurement Guide listed in Appendix A, “Measurement Guides” for additional information.

Figure 3-8. Spectrum Analyzer Measure Menu with Smart Measurements
3-6  NBFM Analyzer

Set the instrument to NBFM Analyzer mode as described in Section 3-2 “Measurement Mode Selection” on page 3-1.

Note  The following Quick Start instructions apply to the NBFM mode. For detailed measurement instructions, refer to the Land Mobile Measurement Guide P/N 10580-00243, listed in Appendix A.

Set the Receiver (Rx) Frequency

1. Press the Freq main menu key.
2. Press the Rx Freq submenu key.
3. Enter the desired center frequency using the keypad, the arrow keys, or the rotary knob. When entering a frequency using the keypad, the submenu key labels change to GHz, MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same affect as pressing the MHz submenu key. The center frequency and span is shown at the bottom of the spectrum display. Press the Span submenu key to adjust the measurement span.
4. Press Setup main key. Use the submenu keys to select the Tone Type.
5. Under the Amplitude main menu, the Auto Rx Range default will adjust the reference level to display the received signal. To adjust the settings, press Adjust Rx Range then set the Ref Level and Scale.

Caution  The maximum input power without damage is 2 Watts (+33 dBm) to the RF In 50 Ohm connector. To prevent damage, use a coupler or attenuator to reduce the input power to below this level when measuring high output power devices.

Set the Signal Source Transmit (Tx) Frequency

The LMR Master contains a signal generator and test patterns for analog FM land mobile radios. The maximum output power is 1.0 milliwatt.

1. Press the Freq main menu key.
2. Press the Tx Freq submenu key.
3. Enter the desired frequency using the keypad, the arrow keys, or the rotary knob. When entering a frequency using the keypad, the submenu key labels change to GHz, MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same affect as pressing the MHz submenu key.
4. Press Setup main key and use the Tx pattern submenu key to set the transmit pattern. Press Enter after selecting a pattern. Based on the pattern selected, set the AM Percentage or the FM Deviation and Tone Deviation (under the More menu).

Note  Bind the transmit frequency to receive frequency using the Rx/Tx Coupling and Coupling offset submenus under the Frequency menu.
5. Under the **Amplitude** main menu, set the signal generator output power using the **Tx Output Lvl** submenu.

6. Press the **Turn Sig-Gen ON** main menu key to turn on the internal signal generator. The menu button display *Turn Sig-Gen OFF* when the generator is running.

**Rx and Tx Power Offset**

To obtain accurate results, compensate for any external attenuation or gain by using the **Rx Power Offset** or **Tx Power offset** submenus under the **Amplitude** main menu key. In power offset mode, the compensation factor is in dB.

Press the **Rx Power Offset** or **Tx Power Offset** submenu key and use the keypad, the arrow keys, or the rotary knob to enter the desired offset value. When using the rotary knob, the value changes in increments of 0.1 dB. Using the **Left/Right** arrow keys changes the value in 10% increments of the value shown on the **Scale** submenu key. The power offsets for Tx and Rx are displayed in the instrument settings summary column on the left side of the measurement display.

**Select the Measurement Types**

**NBFM Analyzer Measurement**

1. Press the **Measurement** main menu key, then press the **NBFM Analyzer** submenu key. Press **Graph Type** to set the displayed graph types (Figure 3-11).

2. Select the graph to change with the **Active Graph** submenu key or the touchscreen. Change the graph with the **Graph Type** submenu key.

![Figure 3-9. NBFM Analyzer Measurements (Active Graph has the Red Outline)](image-url)
NBFM Coverage Measurement

1. Press the Measurement main menu key, then press the NBFM Coverage submenu key twice (Figure 3-13).

2. Refer to the Land Mobile Radio Measurement Guide listed in Appendix A for details on creating a map and coverage mapping.

NBFM Quieting and NBFM SINAD Measurements

Refer to the Land Mobile Radio Measurement Guide listed in Appendix A for details on radio sensitivity testing using the 12 dB SINAD and 20 dB Quieting methods.
3-7 LMR Digital Demodulation Signal Analyzers

Set the instrument to P25/P25p2 Analyzer, NXDN Analyzer, dPMR Analyzer, DMR Analyzer, PTC Analyzer, or TETRA Analyzer mode as described in Section 3-2 “Measurement Mode Selection” on page 3-1.

| Note | The following Quick Start instructions apply to the Land Mobile Radio modes. For detailed measurement instructions, refer to the Land Mobile Measurement Guide P/N 10580-00243, listed in Appendix A. |

Set the Receiver (Rx) Frequency

1. Press the Freq main menu key.
2. Press the Rx Freq submenu key.
3. Enter the desired center frequency using the keypad, the arrow keys, or the rotary knob. When entering a frequency using the keypad, the submenu key labels change to GHz, MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same affect as pressing the MHz submenu key. The center frequency and span is shown at the bottom of the spectrum display. Press the Span submenu key to adjust the measurement span.
4. Press Setup main key. Use the submenu keys to select the Mod Type (Mod Bandwidth in NXDN) and Rx pattern (not applicable to PTC mode).
5. Under the Amplitude main menu, the Auto Rx Range default will adjust the reference level to display the received signal. To adjust the settings, press Adjust Rx Range then set the Ref Level and Scale.

Set the Signal Source Transmit (Tx) Frequency

The LMR Master contains a signal generator and test patterns for LMR antenna and receive system verification. The maximum output power is 0 dBm (1.0 mW).

| Note | Generation of dPMR signals are not currently supported by the LMR Master. |

1. Press the Freq main menu key.
2. Press the Tx Freq submenu key.
3. Enter the desired frequency using the keypad, the arrow keys, or the rotary knob. When entering a frequency using the keypad, the submenu key labels change to GHz, MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same affect as pressing the MHz submenu key.
4. Press Setup main key and use the Tx pattern submenu key to set the transmit pattern. Press Enter after selecting a pattern. PTC Only: Set the Symbol Rate.

Note | If desired, the transmit frequency can be bound to the receive frequency using the Rx/Tx Coupling and Coupling offset submenus under the Frequency menu. |
5. Under the **Amplitude** main menu, set the signal generator output power using the **Tx Output Lvl** submenu.

6. Press the **Turn Sig-Gen ON** main menu key to turn on the internal signal generator. The menu button display **Turn Sig-Gen OFF** when the generator is running.

**Rx and Tx Power Offset**

To obtain accurate results, compensate for any external attenuation or gain by using the **Rx Power Offset** or **Tx Power offset** submenus under the **Amplitude** main menu key. In power offset mode, the compensation factor is in dB. (External attenuation can be created by using an external cable or an external high power attenuator.)

Press the **Rx Power Offset** or **Tx Power Offset** submenu key and use the keypad, the arrow keys, or the rotary knob to enter the desired offset value. When using the rotary knob, the value changes in increments of 0.1 dB. Using the **Left/Right** arrow keys changes the value in 10 \% increments of the value shown on the **Scale** submenu key. When using the **Up/Down** arrow keys, the value changes in the increment shown on the **Scale** submenu key. When using the keypad, enter the new value then press **Enter** or the **dB** submenu key to set the value. The power offsets for Tx and Rx are displayed in the instrument settings summary column on the left side of the measurement display.

**Select the Measurement Types**

**Analyzer Measurements**

1. Press the **Measurement** main menu key, then press the P25 Analyzer, P25p2 Analyzer, NXDN Analyzer, dPMR Analyzer, DMR Analyzer, PTC Analyzer, or the TETRA Analyzer submenu key. Press **Graph Type** to set the displayed graph types (Figure 3-11).
2. Select the graph to change with the Active Graph submenu key or the touchscreen. Change the graph with the Graph Type submenu key.

Figure 3-11. Analyzer Measurements (Active Graph has the Red Outline)
Control Channel Measurement (not available in dPMR, PTC, or TETRA modes)

1. Press the **Setup** main menu and set the Rx Pattern to Ctrl Channel or Voice.
2. Press the **Measurement** main menu key, then press the P25 Control, P25p2 Control, NXDN Control or DMR Control submenu key twice.
3. To save control channel data for additional analysis, insert a formatted USB flash drive into the LMR Master and turn Log Data On.
4. Set the Hex Trigger, Sweep and Set Trigger Value (Figure 3-12). The Hex Trigger menu and Hex Trigger Value menu are used to find a specific opcode in the Control Channel data. To set the hex trigger value, press the Set Trigger Value menu. An on-screen keyboard will display and with the numbers 0 to 9 and the letters A to F. Enter the two character hex value to search for. After entering the value, press **Enter** to set the trigger value. Press **Esc** to cancel entry or changing the current hex value.

   Setting Hex Trigger to On will set the Sweep function to Hold when the hex trigger value is found in the first octet of a packet. The octet row with the found trigger value will be displayed in the middle of the table. If Log Data is set to On, all of the data on the screen is saved and Log Data is set to Off. When Sweep is set back to Run, the unit will continue to collect data and stop on the next instance of the hex trigger value. To continue to capture data to the USB flash drive, set Log Data back to On before setting Sweep to Run mode.

---

**Figure 3-12.** Control Channel Measurement

**Note**

This measurement is captured on an external USB flash drive. The captured data file can not be recalled and displayed on the instrument screen.
Coverage Measurements

1. Press the **Measurement** main menu key, then press the P25 Coverage, P25p2 Coverage, NXDN Coverage, dPMR Coverage, DMR Coverage, PTC Coverage, or TETRA Coverage submenu key twice (**Figure 3-13**).

2. Refer to the Land Mobile Radio Measurement Guide listed in **Appendix A** for details on creating a map and coverage mapping.

---

**Figure 3-13.** Coverage Measurements
Bit Capture Measurement (not available in dPMR, PTC, or TETRA modes)

1. Press the Setup main menu and set the Rx Pattern to Voice.
2. Press the Measurement main menu key, then press the P25 Bit Capture, P25p2 Bit Capture, NXDN Bit Capture, or DMR Bit Capture submenu key.
3. To save bit capture data for additional analysis, insert a formatted USB flash drive into the LMR Master and turn Log Data On. (Figure 3-14).

IQ Capture Measurement

1. Insert a formatted USB flash drive in the USB port of the LMR Master.
2. Press the Measurement main menu key, then press the P25 IQ Capture, P25p2 IQ Capture, NXDN IQ Capture, dPMR IQ Capture, DMR IQ Capture, or TETRA IQ Capture submenu key.
3. After a few seconds the LMR Master will display the message “IQ Capture Complete”.
4. The IQ data is stored on the USB flash drive under the /usr folder in a date stamped folder. The file will be IQ_CAPTUREyearmonthdaytime.p25 (or .p252, .nxdn, .dpmr, .dmr2, .ptc, or .tetra).

Note
These measurements are captured on an external USB flash device. The captured data file cannot be recalled and displayed on the instrument screen.
3-8 Saving Measurements

The LMR Master can save files in the following formats based on measurement mode and installed options:

- `filename.spa` for SPA measurement
- `filename.mna` for VNA and VVM measurements
- `filename.s2p` S2P (SnP) for VNA S-parameter measurements
- `filename.hipm` for High Accuracy Power Meter measurements
- `filename.pm` for Power Meter measurements.
- `filename.cwsg` for CWSG measurements.
- `filename.afp` for AM/FM/PM measurements
- `filename.ia` for Interference Analysis measurements
- `filename.cs` for Channel Scanner measurements
- `filename.wmxd` for WiMAX
- `filename.wmxxe` for Mobile WiMAX
- `filename.lte` for LTE measurements
- `filename.nbfm` for NBFM measurements
- `filename.p25` for P25 measurements
- `filename.p252` for P25p2 measurements
- `filename.nxdn` for NXDN measurements
- `filename.dpmr` for dPMR measurements
- `filename.dmr2` for DMR measurements
- `filename.ptc` for PTC measurements
- `filename.tetra` for TETRA measurements
- `filename.jpg` for JPEG images
- `filename.stp` for Setup files
- `filename.lim` for Limit lines

**Note** The LMR Master is not fully supported in Master Software Tools.

**Procedure for Saving Files:**

1. Press **Shift** then **File (7)**.
2. Press **Save**.
3. Press **Change Save Location** and set the current location to be the USB flash drive or internal memory, and then press **Set Location**.
4. Press **Change Type** (Setup/JPG/...) and select the desired file type from the Select File Type list box and press **Enter**.
5. Enter the filename by using the keyboard and then press **Enter**.

Refer to Chapter 4, “File Management” for additional details about working with files.
3-9 External Power On

This feature allows the LMR Master to restart when external DC power is applied.

This source of external power is applied to the power connector as described in “External Power” on page 2-10. This connector is shown as item 9 in Figure 2-8 on page 2-9. When this feature is enabled from the Power–On menu, the LMR Master (when Off) automatically restarts when external DC power is applied. Refer to “Power–On Menu” on page 5-14.

When this feature is enabled, the LMR Master in the off state will turn on when external DC power is applied. The instrument turns off when external power is removed, even if a battery is installed. This is useful for high-reliability remote operation, where the instrument may need to be rebooted using a remotely-controlled power switch.

If the instrument is turned on with the power switch, then external power is removed, the instrument will continue to run until the battery is depleted. It will come on and the battery will begin recharging when external power is applied. This state is useful when the instrument is in a location where the power source may be interrupted.
Chapter 4 — File Management

4-1 Introduction

This chapter describes the file management features of the LMR Master and describe the File menu. The submenus under this menu allow you to save, recall, copy, and delete files in internal memory or an external USB flash drive.

4-2 File Types

Filename extensions that are used in the LMR Master:

- *.spa for SPA measurement
- *.mna for VNA and VVM measurements
- *.s2p for S2P (SnP) for VNA S-parameter measurements
- *.hipm for High Accuracy Power Meter measurements
- *.pm for Power Meter measurements.
- *.cwsg for CWSG measurements.
- *.afp for AM/FM/PM measurements
- *.ia for Interference Analysis measurements
- *.cs for Channel Scanner measurements
- *.wmxd for WiMAX
- *.wmxe for Mobile WiMAX
- *.lte for LTE measurements
- *.nbfm for NBFM measurements
- *.p25 for P25 measurements
- *.p252 for P25p2 measurements
- *.nxdn for NXDN measurements
- *.dpmr for dPMR measurements
- *.dmr2 for DMR measurements
- *.ptc for PTC measurements
- *.teta for TETRA measurements
- *.jpg for JPEG images
- *.stp for Setup files
- *.lim for Limit lines

Note: S2P is a standard ASCII text file format that is used for scattering parameters from a 2-Port measurement. This is a subset of SnP (where n equals the number of ports).
4-3 Managing Files

Press the **Shift** key then the **File** (7) key on the numeric keypad to list the **File** menu.

| Note | When navigating through the **File** menu, pressing the **Esc** key returns to the previous menu. |

**Save Files**

**Set the Save Location**

Press **Save** then the **Change Save Location** submenu key and select the location to save files. Files can be saved to the internal memory or to an external USB flash drive. New folders can be created at either location. Press **Refresh Directories** to update the location tree. Press the **Set Location** key to set the save location.

**Save Measurement As**

The **Save Measurement As** key is used to quickly save measurements with a specific file name. The LMR Master saves the measurement with the latest file name that was used to save a measurement and with a number that is automatically incremented and appended to the end of the file name. For instance, if the last measurement was saved with the name *System Return Loss*, **Save Measurement As** saves the next measurement as *System Return Loss_1*, *System Return Loss_2*, etc. The file name used can be changed using the **Save** dialog box (Figure 4-1).

**Save a Measurement**

Press the **Save Measurement** key and enter the name for the measurement file.

**Save a Setup**

Press the **Save** submenu key, type a name for the setup file, confirm that the file type is **Setup** using the **Change Type** key or the touchscreen, and then press **Enter** to save.

**Create a Menu Shortcut for a Setup File**

Press the **Recall** submenu key to display saved setup files. Locate the setup file to shortcut and then using the touch screen press and hold on the file name for a few seconds. Select a location in the shortcut grid to save the setup file.

**Save a Measurement Screen as JPEG**

Press the **Save** submenu key, type a name for the JPEG file, confirm that the file type is **Jpeg**, and press **Enter** to save.
Save Dialog Box

The save dialog box (Figure 4-1) is used to store files on the internal memory or an external flash drive. The file type, file name, and save location are set starting with this display. Refer to “Save Menu” on page 4-9 and “Save Location Menu” on page 4-10 for details.

Note: The Save Dialog Box will vary based on current measurement mode.

![Save Dialog Box](image)

**Figure 4-1.** Save Dialog Box

Quick Name Keys

Quick Name keys (located below the keyboard in Figure 4-1) allow you to enter quick names for frequently used parts of file measurement names. To edit the keys, press the Shift key, then the File (7) key. Press Save then the Change Quick Name key, and select one of the Quick Names for editing. Press Enter and enter the new name for the key. Press Enter again, and the new name is displayed on the Quick Name key.

When entering filenames, use the quick name keys in any order in combination with the keyboard to create measurement filenames.
Recall Files

The recall menu enables you to view all of the Measurement and Setup files in the internal memory and in an external USB flash drive.

You can sort the recall menu by name, date, or type. You can also choose to view only measurement files or setup files by pressing File Type on the Recall dialog box and selecting the file type that you want to view.

Recall a Measurement

From the File menu, press the Recall Measurement submenu key, select the measurement with the touchscreen, rotary knob, or the Up/Down arrow keys, and then press Enter.

Recall a Setup

Press the Recall submenu key. Confirm that the file type is Setup or All. Select the setup file (.stp) with the touchscreen, rotary knob, or the Up/Down arrow keys, and then press Enter.

Recall Dialog Box

The Recall dialog box (Figure 4-2) opens previously saved measurements and setups. Refer to the “Recall Menu” on page 4-12 for additional information.

---

Figure 4-2. Recall Dialog Box
**Copy Files**

The steps below describe copying a file from internal memory to an external flash drive. Select the files to copy in the top window and the location for the files (to be copied) in the bottom window (Figure 4-3). Refer to the “Copy Menu” on page 4-13 for additional information.

1. Insert a USB flash drive into either USB Type A port of the LMR Master.
2. From the **File** main menu, press the **Copy** submenu key. The Copy menu and Copy dialog box are displayed.
3. Select the files that are to be copied. To select multiple files, highlight the first file, then press the **Select or De-Select** key to keep the file selected. The selected file is outlined in blue. Repeat with all the files that are to be copied. To display files in a folder, select the folder and press the **Enter** key.
4. Press the **Scroll** key and highlight the USB flash drive in the lower window using the touch screen or the **Up/Down** arrow keys. The **Scroll** submenu key toggles between source and destination, **Src** (top window) and **Dst** (bottom window).
5. Press the **Copy** key to copy the files to the flash drive.

![Figure 4-3. Copy Dialog Box](image)
Delete Files

Press the Delete submenu key. Highlight the file to be deleted with the touchscreen or the Up/Down arrow keys. Press the Select or De-Select key. Selected files are outlined in blue. Press the Delete key and then press Enter to delete the selected file.

Delete Dialog Box

Press the Delete submenu key to open the Delete dialog box (Figure 4-4). The menus allow sorting by file type, name, and saved date. Refer to the “Delete Menu” on page 4-14 for additional information.

![Figure 4-4. Delete Dialog Box](image-url)
4-4 File Menu Overview

Open this menu by pressing the **Shift** key, then the **File** (7) key.

**Figure 4-5.** File Menu
4-5  File Menu

Key Sequence: File

<table>
<thead>
<tr>
<th>File</th>
<th>Save Measurement As</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Save Measurement As</td>
</tr>
<tr>
<td>Save</td>
<td>Save Measurement</td>
</tr>
<tr>
<td>Save</td>
<td>Save On Event</td>
</tr>
<tr>
<td>Recall</td>
<td>Recall Measurement</td>
</tr>
<tr>
<td>Recall</td>
<td>Recall</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete</td>
</tr>
</tbody>
</table>

**Save Measurement As:** Press this submenu key to save the current setup with a user defined filename. The default filename is changed using the Save menu. To change the default file name, type in a new file with the touch screen keyboard and press **Enter**. After a few seconds, the screen returns to File menu. Press the Save Measurement As key again and the new file name is used.

**Save Measurement:** Press this submenu key to display the “Save Menu” on page 4-9 and the touch screen keyboard. Measurements can be saved to internal memory or to a USB flash drive. The saved measurement can be named by using the touch screen keyboard. By default, measurements are saved to internal memory in a directory named /user. The save destination is set with the “Save Location Menu” on page 4-10.

**Save:** Press this submenu key to display the “Save Menu” on page 4-9 and the touch screen keyboard. Measurements can be saved to internal memory or to a USB flash drive. The saved setup, measurement, or JPEG file can be named by using the touch screen keyboard. By default, measurements are saved to internal memory in a directory named /user. The save destination is set with the “Save Location Menu” on page 4-10.

**Save on Event:** Press this submenu key to display the “Save On Event Menu” on page 4-11. This submenu key is displayed only in LMR Analyzer modes.

**Recall Measurement:** Press this submenu key to display the “Recall Menu” on page 4-12. This menu is for recalling measurements from internal memory or from a USB flash drive.

**Recall:** Press this submenu key to display the “Recall Menu” on page 4-12. This menu is for recalling measurement or setup data from internal memory or from a USB flash drive.

**Copy:** Press this submenu key to display the “Copy Menu” on page 4-13. The Copy menu is for copying files or folders from internal memory or a USB flash drive.

**Delete:** Press this submenu key to display the “Delete Menu” on page 4-14 and a selection box that shows the setup and measurement names and the type, date, and time that the information was saved. Use the rotary knob or the **Up/Down** arrow keys to highlight the file that is to be deleted and press the Delete submenu key, then press **Enter**. Press the **Esc** key to cancel the operation. Note that deleted files cannot be recovered.

---

**Figure 4-6.** File Menu
Save Menu

The top keys in the Save menu display the available file-type save options based on the current measurement mode.

Key Sequence: **File > Save**

| Change Quick Name: Press this submenu key to change the Quick Names that are displayed at the bottom of the touch screen keyboard (*Figure 4-1*). Select the Quick Name to edit and press **Enter**. Type the new Quick Name and press **Enter** again. The new Quick Name is displayed on the corresponding Quick Name button below the keyboard. |
| Change Save Location: Press this submenu key to open the “Save Location Menu”. |
| Change Type Setup/JPEG/... Press this submenu key to select among the various file types available for setup and measurement data. This submenu key also opens the File Type menu with a submenu key to select Full screen or Graph Only images for JPEG file types. |

*Figure 4-7. Save Menu*
**Save Location Menu**

This menu and dialog box are used to create folders and to select the location where the LMR Master saves the current file. Select folders or drives with the **Up/Down** keys, the rotary knob, or the touch screen.

**Note**

Only folders (not files) are visible in the Save Location dialog box. To view files, use the **Recall Menu** on page 4-12.

**Key Sequence:** **File** > **Save** > **Change Save Location**

<table>
<thead>
<tr>
<th>Save Location</th>
<th>Sort By</th>
<th>Name Date Type: Press this submenu key to sort the folders by Name, Type, or Date.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Sort Order</td>
<td>Asc Desc: Press this submenu key to display the folder names in ascending or descending order.</td>
</tr>
<tr>
<td></td>
<td>Create Folder</td>
<td>Press this submenu key to create a new folder in the highlighted location or folder. Name the new folder in the create directory dialog box.</td>
</tr>
<tr>
<td></td>
<td>Set Location</td>
<td>Press this submenu key to set the current location for saving files and then return to the <strong>Save Menu</strong> on page 4-9.</td>
</tr>
<tr>
<td></td>
<td>Refresh Directories</td>
<td>Press this submenu key to update the display.</td>
</tr>
</tbody>
</table>

**Figure 4-8.** Save Location Menu

**Figure 4-9.** Select Save Location Dialog Box
Save On Event Menu

In all Spectrum Analyzer, Interference Analyzer, and LMR Analyzer modes, this menu is used to auto save measurements to internal memory after a set events occur.

Key Sequence: File > Save On Event

...Crossing Limit
On  Off: Toggling this submenu key to On sets the LMR Master to save the measurement to internal memory when the measurement has crossed a defined limit line that has been created with the Limit menu.

...Sweep Complete
On  Off: Toggling this submenu key to On sets the LMR Master to save the measurement to internal memory after the current sweep is complete. If Save Then Stop is toggled Off, then a measurement is saved after every sweep.

Save Then Stop
On  Off: Toggling this key to On sets the LMR Master to stop the sweep after a measurement is saved. With this key Off and Sweep Complete On, a measurement is saved after every sweep.

Clear All: Press this key to turn Off all three save-on-event keys:
- Crossing Limit
- Sweep Complete
- Save Then Stop

Back: Press this key to return to the “File Menu” on page 4-8.

Figure 4-10. Save On Event Menu (Spectrum and Interference Analyzer Modes)

Squelch Crossing
On  Off: Toggling this submenu key to On sets the LMR Master to save the measurement to internal memory when the measurement has crossed a defined squelch level that has been set via the Setup menu.

Back: Press this key to return to the “File Menu” on page 4-8.

Figure 4-11. Save On Event Menu (LMR Analyzer Modes)
Recall Menu

This menu and its dialog box are used to select the location from which the LMR Master recalls a file. Select folders or drives with the Up/Down arrow keys, the rotary knob, or the touch screen.

Key Sequence: **File > Recall**

Use these menu keys to change the way files are listed in the Recall dialog box. Navigate to the desired file, then press Enter to recall.

When recalling a saved setup, all current instrument settings are replaced by the stored setup information. When recalling a saved measurement and multiple traces are displayed, parameter settings shown on the instrument screen may reflect those of the recalled trace or the active trace, depending on the measurement mode or other factors.

**Sort By**

**Name**  **Date**  **Type**: Press this submenu key to sort files and folders by the file name, by the type of file, or by the date that the file or folder was saved.

**Sort Order**

**Asc**  **Desc**: Displays the folder or file in ascending or descending order based on the selection in the Sort By key.

**File Type**: Press this submenu key to select the type of file to be viewed. The file type can be changed with the Up/Down arrow keys, the rotary knob, or the touch screen. Press **Enter** to make the selection. Refer to Section 4-2 “File Types” for file type descriptions.

**Refresh Directories**: Press this key to update the display.

Figure 4-12. Recall Menu
Copy Menu

This menu and dialog box are used to copy folders and files. Select folders or files with the **Up/Down** arrow keys, the rotary knob, or the touch screen. Figure 4-3 on page 4-5 shows the Copy dialog box with two JPEG images and one folder (including the folder contents) selected and ready to be copied to the USB flash drive. Highlight a folder and press **Enter** to view the contents.

Key Sequence: **File > Copy**

---

**Sort By**

Name  Type  Date:  Press this submenu key to sort file and folder lists by name, by type of file, or by the date that a file was saved.

**Sort Order**

Asc    Desc:  Press this submenu key to display the folders or files in ascending or descending order based on the selection in the Sort By key.

**File Type**

Press this submenu key to select the type of files to view for copying. The file type can be changed with the **Up/Down** arrow keys, the rotary knob, or the touch screen. Press **Enter** to make the selection. Refer to Section 4-2 “File Types” for file type descriptions.

**Refresh Directories**

Press this submenu key to update the display.

**Scroll**

Src    Dst:  Press this submenu key to use the scroll function in the Source Folder (Src or top panel) or in the Destination Folder (Dst or bottom panel). Refer to Figure 4-3.

**Select or De-Select**

Press this submenu key to select or deselect the files or folders to be copied. When selected, a file or folder is outlined in blue. Refer to Figure 4-3.

**Copy**

Press this submenu key to copy the files or folders that are selected in the top window to the destination that is selected in the bottom window. A dialog box indicates when the copying is complete. If a file with the same name exists in the destination folder, then a warning box is displayed to allow file overwrite or cancel.

---

**Figure 4-13.** Copy Menu
Delete Menu

This menu and dialog box are used to delete folders and files. Select folders or files with the **Up/Down** arrow keys, the rotary knob, or the touch screen.

**Key Sequence:** File > Delete

---

**Sort By**

**Name  Date  Type:** Press this submenu key to sort files and folders by name, by the type of file, or by the date that the file or folder was saved.

**Sort Order**

**Asc  Desc:** Press this submenu key to display the folders or files in ascending or descending order based on the selection in the Sort By key.

**File Type:** Press this submenu key to select the type of file to be deleted. The file type can be changed with the **Up/Down** arrow keys, the rotary knob, or the touch screen. Press **Enter** to make the selection. Refer to **Section 4-2 “File Types”** for file type descriptions.

**Select or De-Select:** Press this submenu key to select or deselect the files or folders to be deleted. When selected, a file or folder is outlined in blue.

**Delete:** Press this submenu key to open the Delete dialog box. Press **Enter** to delete the selected item, or press **Esc** to Cancel.

**Refresh Directories:** Press this submenu key to update the display.

---

**Figure 4-14.** Delete Menu
Chapter 5 — System Operations

5-1 Introduction

This chapter describes the LMR Master system operations.

- “System Menu Group Overview” on page 5-2
- “System Menu” on page 5-4
- “Preset Menu” on page 5-18
- “Self Test” on page 5-18
- “Updating the LMR Master Firmware” on page 5-19

The other menus (Sweep, Measure, Trace, and Limit) are described in the Measurement Guides that are listed in Appendix A.
5-2 System Menu Group Overview

To access the functions under the System menu, press the **Shift** key, then the **System (8)** key. Figure 5-1 and Figure 5-2 show the menu group that is accessible from the System menu. Menu maps typically display all possible submenu keys, although some keys are displayed on the instruments only under special circumstances (refer to the menu descriptions on the following pages).

Note that the menus that are indicated by numbered circles are shown in Figure 5-2.

System Menu Map 1

---

**Figure 5-1.** System Menu Map – Part 1
To access the functions under the System menu, press the **Shift** key, then the **System (8)** key.

**Note** The display settings will vary based on the current measurement mode.
### 5-3 System Menu

**Key Sequence:** Shift, System (8)

**Status:** Press this submenu key to display the current system status, including the operating system and firmware versions, temperatures and other details such as current battery information. Press Esc or Enter to return to normal operation.

**Self Test:** Press this submenu key to initiate a series of diagnostic tests that check the components of the instrument. A display lists the individual tests with a pass or fail indication. Press Esc or Enter to return to normal operation.

**Application Self Test:** Press this submenu key to initiate a series of diagnostic tests related to the performance of the instrument for specific applications. A display lists the individual tests with a pass or fail indication. Press Esc or Enter to return to normal operation.

**GPS:** Opens the “GPS Menu” on page 9-3. This submenu key is displayed only when the GPS (Option 31) is installed.

**Calibrate Touch Screen:** Press this submenu key to start the touch screen calibration. Run the calibration procedure when the instrument is not responding to your screen taps as expected.

**Application Options:** Press this submenu key to open a menu to select application options. This varies depending upon the measurement (application) mode. Refer to “Application Options Menu” on page 5-5.

**System Options:** Press this submenu key to open the “System Options Menu” on page 5-11.

---

**Note**

**Calibrate Touch Screen Shortcut**

Press Shift then 0 to open the Calibrate Touch Screen display. Press Enter to start the calibration or Esc to cancel.
5-4 Application Options Menu

Key Sequence: **Shift, System (8)** > Application Options

The display of this menu varies based on the current measurement mode. In addition to the following information, refer to the appropriate Measurement Guide listed in Appendix A.

**VNA Mode**

*Units*

- **m ft**: Press this submenu key to toggle the units setting to metric (meters, or m) or to U.S. (feet, or ft). Press **Enter** to accept the changes, or press the **Esc** key to return to normal operation without changing the setting.

*Trace Label*

- **On Off**: Press this submenu key to toggle the trace labels On or Off.

*Meas Gain Range*

- **Auto**: Press this submenu key to set the Measurement Gain Range Mode to Auto. In this mode, the instrument adjusts the gain automatically to provide the best overall system performance (dynamic range and high level noise).

- **Fixed**: Press this submenu key to set the Measurement Gain Range Mode to Fixed. In this mode, the gain of the instrument is always set to the low gain setting. For most applications, Auto mode is recommended. For certain types of filter measurements (mostly in the range less than 500 MHz), the instrument may toggle between low gain and high gain modes as the signal level rises from the noise to the pass band of the filter, resulting in extra ripple. Setting the Gain Range to fixed may address that problem.

*Meas Menu*

- **Field VNA**: Press this submenu key to toggle between Field (a simplified subset of the standard VNA menu structure) and VNA (standard menu structure).

*Back*

- Press this submenu key to return to the “System Menu” on page 5-4.

---

**Figure 5-4.** Application Options Menu (VNA Mode)
SPA Mode

Key Sequence: **Shift, System** (8) > Application Options

---

**Impedance**

*50 Ohm  75 Ohm  Other:* Press this submenu key to toggle the impedance setting to 50 ohm, 75 ohm, or Other impedance value. Selecting 75 ohm selects the 7.5 dB loss of the Anritsu 12N50-75B adapter. For other adapters, select Other and enter the appropriate loss.

**Bias Tee (Option 10 required):** Opens the Bias Tee submenu. When turned on, the Bias Tee voltage and current is shown in the lower left corner of the display.

- **Bias Tee:** Toggles On and Off the variable power supply.
- **Bias Tee Voltage:** Use this submenu to set the power supply voltage.
- **Current:** Toggle the current between Low and High.
- **Back:** Press this submenu key to return to the Application Options Menu.

**Back:** Press this submenu key to return to the “System Menu” on page 5-4.

---

**Figure 5-5.** Application Options Menu (SPA Mode)
DMR Mode

Key Sequence: Shift, System (8) > Application Options

Load DMR Patterns: Press this submenu key to load additional DMR signal patterns into the instrument. Refer to “Updating Signal Generator Patterns” on page 5-10 before continuing.

Back: Press this submenu key to return to the “System Menu” on page 5-4.

Figure 5-6. Application Options Menu (DMR Mode)

P25 Mode

Key Sequence: Shift, System (8) > Application Options

Load P25 Patterns: Press this submenu key to load additional P25 signal patterns into the instrument. Refer to “Updating Signal Generator Patterns” on page 5-10 before continuing.

Back: Press this submenu key to return to the “System Menu” on page 5-4.

Figure 5-7. Application Options Menu (P25 Mode)
P25p2 Mode

Key Sequence: Shift, System (8) > Application Options

<table>
<thead>
<tr>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load P25p2 Patterns</td>
</tr>
<tr>
<td>Back</td>
</tr>
</tbody>
</table>

**Load P25p2 Patterns**: Press this submenu key to load additional P25p2 signal patterns into the instrument. Refer to “Updating Signal Generator Patterns” on page 5-10 before continuing.

**Back**: Press this submenu key to return to the “System Menu” on page 5-4.

![Application Options Menu (P25p2 Mode)](image)

Figure 5-8. Application Options Menu (P25p2 Mode)

NXDN Mode

Key Sequence: Shift, System (8) > Application Options

<table>
<thead>
<tr>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load NXDN Patterns</td>
</tr>
<tr>
<td>Back</td>
</tr>
</tbody>
</table>

**Load NXDN Patterns**: Press this submenu key to load additional NXDN signal patterns into the instrument. Refer to “Updating Signal Generator Patterns” on page 5-10 before continuing.

**Back**: Press this submenu key to return to the “System Menu” on page 5-4.

![Application Options Menu (NXDN Mode)](image)

Figure 5-9. Application Options Menu (NXDN Mode)
PTC Mode

Key Sequence: **Shift, System (8)** > Application Options

- **Load PTC Patterns:** Press this submenu key to load additional PTC signal patterns into the instrument. Refer to “Updating Signal Generator Patterns” on page 5-10 before continuing.

- **Back:** Press this submenu key to return to the “System Menu” on page 5-4.

**Figure 5-10.** Application Options Menu (PTC Mode)

TETRA Mode

Key Sequence: **Shift, System (8)** > Application Options

- **Load TETRA Patterns:** Press this submenu key to load additional TETRA signal patterns into the instrument. Refer to “Updating Signal Generator Patterns” on page 5-10 before continuing.

- **Back:** Press this submenu key to return to the “System Menu” on page 5-4.

**Figure 5-11.** Application Options Menu (TETRA Mode)
Updating Signal Generator Patterns

Prepare the USB Flash Memory Device
1. The USB flash memory device must be formatted as either FAT or FAT32 file system.
2. The USB flash memory device should have at least 1 GB of free space.
3. Copy the ‘tx’ folder containing all of the patterns to the top level directory of the USB device.

Update the S412E Patterns

Note: This process needs to be repeated for each LMR analysis mode where patterns need to be updated (i.e. P25, P25p2, NXDN, DMR, TETRA, PTC).

1. Power on the S412E and insert the USB flash memory device into one of the USB ports on the LMR Master.
2. Enter the desired analysis mode for the patterns being loaded. For example NXDN, PTC, P25, P25p2, TETRA, or DMR mode.
3. Execute the following sequence:
   a. Access the System Menu by pressing the Shift key, then press the 8 key on the keypad.
   b. In the System menu, select Application Options > Load Patterns, then press Enter when ready to start loading patterns.
   c. Wait for the unit to end the loading process (this can take several minutes), press Enter as directed, and the patterns will be loaded.
   d. Press the Esc key when done.
4. Repeat Step 2 and Step 3 for each analysis mode desired.
5-5  System Options Menu

System Options Menu

Key Sequence:  **Shift > System (8) > System Options**

<table>
<thead>
<tr>
<th>System Options Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date &amp; Time</td>
<td>Press this submenu key to display a dialog box for setting the current date and time. Use the submenu keys or the <strong>Left/Right</strong> arrow keys to select the field to be modified. Use the keypad, the <strong>Up/Down</strong> arrow keys, or the rotary knob to select the date and time. Press <strong>Enter</strong> to accept the changes, or press the <strong>Esc</strong> key to return to normal operation without making changes.</td>
</tr>
<tr>
<td>Ethernet Config</td>
<td>Press this key to display the Ethernet submenu and to open the Ethernet Editor dialog box, where you can set the instrument IP address. For details, refer to Chapter 6, “Ethernet Connectivity”.</td>
</tr>
<tr>
<td>Language</td>
<td>Press this submenu key to open a list box and select a built-in language for the instrument display. Press <strong>Enter</strong> to apply the change, or press <strong>Esc</strong> to cancel. The languages that are currently available are: English, French, German, Spanish, Japanese, Chinese, Korean, Italian, Russian, and Portuguese. You can edit non-English language captions using Master Software Tools (MST). If a mode does not have language translations available, then English is the default language. <strong>Caution:</strong> A firmware update or any instrument reset will overwrite modifications you may have made in any of the language files.</td>
</tr>
<tr>
<td>Display</td>
<td>The Display submenu key opens the “Display Settings Menu” on page 5-15, allowing brightness control and the selection of different display attributes.</td>
</tr>
<tr>
<td>Name</td>
<td>Press this submenu key to open the Unit Name dialog, where you can enter a name for the instrument, using the touch screen keyboard. Press <strong>Enter</strong> to save the name. The assigned instrument name appears in measurement files, setup files, limit line files, and MST reports. It is displayed on the browser page banner when the instrument is connected to a remote PC or mobile device.</td>
</tr>
<tr>
<td>Volume</td>
<td>Press this submenu key to view or adjust the speaker volume. The current volume setting is displayed in the Volume input box. Use the numeric keypad, the <strong>Up/Down</strong> arrow keys, or the rotary knob to change the value, and press <strong>Enter</strong> to apply the change.</td>
</tr>
<tr>
<td>Reset</td>
<td>Press this submenu key to open the “Reset Menu” on page 5-17.</td>
</tr>
<tr>
<td>More</td>
<td>Press this submenu key to open the “System Options 2/2 Menu” on page 5-12.</td>
</tr>
</tbody>
</table>

Figure 5-13. System Options Menu
System Options 2/2 Menu

Key Sequence: Shift > System (8) > System Options > More

Share CF & Pwr Offset
All Modes  Not Shared: Press this submenu key to toggle the setting between All Modes and Not Shared. Select All Modes to have the current center frequency setting and power offset setting carried over when changing measurement modes. This function is not applicable to measurements that do not have a center frequency or power offset setting or to measurements in which the current center frequency or power offset setting is outside the range of the new measurement.

Set Remote Access Password: Press this submenu key to open the Password entry dialog (see Figure 5-15). Use the touch screen keyboard to enter the new password. Passwords may contain digits, uppercase and lowercase letters, and the symbols - _ + . (hyphen, underscore, plus, period). Press Enter to save or Esc to cancel.

Setting the remote password and rebooting the instrument will lock it from Telnet and FTP connections. This means that connecting to the instrument via Master Software Tools (v2.21.1 or later), Wireless Remote Tools (WRT), or the Web Remote Control browser interface will require the set password. To unlock the instrument, remove the password by setting it to blank. The password is also removed following a Master Reset, Factory Defaults reset, or a firmware update.

Power–On: Press this submenu key to open the “Power–On Menu” on page 5-14.

Input Power Warning
On Off: Press this submenu key to toggle a brief display of the input power caution message at startup (see Figure 5-16).

Back: Press this submenu key to return to the “System Options Menu” on page 5-11.

Figure 5-14. System Options Menu 2/2

Warning
Do not set a remote access password when using SCPI commands to communicate with the instrument.
To prevent damage to the instrument, NEVER connect a transmitter directly to the input ports.

Input power limits per port:
- RF In port: 50 Ohms, +33 dBm MAX, +50 VDC MAX
- VNA port 1: 50 Ohms, +23 dBm MAX, +50 VDC MAX
- VNA port 2: 50 Ohms, +23 dBm MAX, +50 VDC MAX

Press ESC to continue.
Power–On Menu

Key Sequence: **Shift > System (8) > System Options > More > Power–On**

<table>
<thead>
<tr>
<th>Power–On</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Switch</td>
</tr>
<tr>
<td>When DC Applied</td>
</tr>
<tr>
<td>Back</td>
</tr>
</tbody>
</table>

**Power Switch**: Press this submenu key to set the LMR Master for normal use of the On/Off button on the instrument front panel.

**When DC Applied**: Press this submenu key to set the LMR Master to automatically restart when DC power is applied to the External Power connector (see **Figure 2-8 on page 2-9**). Refer to “External Power On” on page 3-24.

**Back**: Press this submenu key to return to the “System Options 2/2 Menu” on page 5-12.

**Figure 5-17.** Power–On Menu
Display Settings Menu

Key Sequence: **Shift, System (8) > System Options > Display**

- **Brightness**: Opens the “Brightness Settings Menu” on page 5-16.
- **Display Blank**: Opens the message box illustrated in Figure 5-19. Press **Enter** to turn off the display, or press **Esc** to abort. To turn the display back on, press any key (except the Power button) three times in rapid succession. A power cycle also turns the display back on.
- **Default Colors**: Sets the display colors to the factory defaults. Used for normal viewing.
- **Black on White**: Sets the display colors to black on a white background. Used for printing and viewing in broad daylight conditions. See Figure 2-7 on page 2-8 for illustrations of the display color schemes selectable in this submenu.
- **Night Vision**: Sets the display to a red-tinted color on a black background. The front panel keypad is backlit in red. This setting is optimized for nighttime viewing.
- **High Contrast**: Increases the black and white contrast of the default display. This setting is used in challenging viewing conditions.
- **Color on White**: Sets the display background to white, the grid to gray, and leaves sweep data in color. This setting is used for printing and viewing in broad daylight conditions.

**Back**: Press this submenu key to return to the “System Options Menu” on page 5-11.

![Display Settings Menu Diagram]

**Figure 5-18.** Display Settings Menu

**Figure 5-19.** Display Blank Message Box

- **Display Blank**: To turn off the display, press **<Enter>**, or press **<Esc>** to abort.

  Three rapid keypresses, or turning power off and on, will turn on the display.
Brightness Settings Menu

Key Sequence: Shift, System (8) > System Options > Display > Brightness

The brightness of the display can be adjusted to optimize viewing under a wide variety of lighting conditions.

**Brightness:** Press this key to open the Brightness Editor window, where you can adjust the display brightness level from 0 to 100, with 100 being the brightest. See Figure 5-21. Use the rotary knob to adjust the value in increments of 5, or press the Up/Down arrow keys to change the value in increments of 25. Press the Left or the Right arrow key to jump to 0 or 100, respectively. Press Enter to accept the change. All display elements on the instrument screen are affected by the Brightness setting.

**Auto Dim On/Off:** Press this key to toggle the display auto-dimming feature on and off. Enabling auto-dim can extend battery life.

**Auto Dim Delay:** Press this key to adjust the amount of idle time, from 1 to 15 minutes, before the instrument display goes dim. Use the arrow keys or the rotary knob to adjust the value in increments of 1. You can also use the numeric keypad, then press Enter. Out-of-range values are ignored.

**Auto Dim Brightness:** Press this key to select the brightness percentage level of the display when it is dimmed. Use the arrow keys or the rotary knob to adjust the value in increments of 5%, from 0% to 25%. You can also use the numeric keypad, then press % or the Enter key. Out-of-range values are ignored.

**Back:** Press this key to return to the "Display Settings Menu" on page 5-15.

---

**Figure 5-20.** Brightness Settings Menu

---

**Figure 5-21.** Brightness Editor Input Box
5-6  Reset Menu

Key Sequence:  **Shift, System (8) > System Options > Reset**

| Back                   | Master Reset: Press this submenu key to restore the instrument to factory defaults as described above and to delete all user files from the instrument internal memory. The instrument will power cycle when the operation is complete. Press **Enter** to initiate the reset, or press **Esc** to abort.  
|------------------------|---
| Update Firmware        | **Note:** This same reset sequence can be initiated when turning the LMR Master on by pressing and holding the **Esc** key until the Anritsu splash screen is displayed.
| Factory Defaults       | **Update Firmware:** Press this submenu key to update the instrument operating system with an external USB drive. Press **Load Firmware** to start the update procedure, or press the **Menu** key to cancel and display the Menu key screen of application icons. Refer to "Updating the LMR Master Firmware" on page 5-19 for additional information on firmware update.
|                         | **Back:** Press this submenu key to return to the “System Options Menu” on page 5-11.
| Reset                  | **Note:** This same reset sequence can be initiated when turning the LMR Master on by pressing and holding the **System (8)** key until the Anritsu splash screen is displayed.
| Factory Defaults       |
| Factory Defaults       |
| Master Reset           |
| Master Reset           |
| Update Firmware        |
| Update Firmware        |

**Figure 5-22.** Reset Menu
5-7 Preset Menu

Key Sequence: Shift, Preset (1)

Preset: This key resets all parameter settings for the current measurement mode to their factory default values, and switches the display to the default view for that mode. Measurement settings specific to other modes, or applications, are not affected.

Save Setup: Press this submenu key to open the Save dialog box (Figure 4-1 on page 4-3) to name and save the current operating settings, allowing them to be recalled later to return the instrument to the state it was in at the time the setup was saved.

The saved setup can be named using the touch screen keyboard. Use the Caps key to select an upper case letter. Use the Left/Right directional arrows to move the cursor position. Press Enter to save the setup.

Note: Set the File type as Setup. Refer to “Save Menu” on page 4-9 for details.

Recall Setup: Press this submenu key to select and recall a previously stored instrument setup using the “Recall Menu” on page 4-12. Use the rotary knob, the Up/Down arrow keys, or the touchscreen to highlight the saved setup, and press Enter. All current instrument settings are replaced by the stored setup information.

Figure 5-23. Preset Menu

5-8 Self Test

At power on, the LMR Master runs through a series of quick checks to ensure that the system is functioning properly. The System Self Test runs a series of tests that are related to the instrument itself. The Application Self Test runs a series of tests that are related to the current operating mode of the instrument.

If the LMR Master is within the specified operating range with a charged battery and the self test fails, contact your Anritsu Service Center at http://www.anritsu.com/contact-us.

To start a self test when the system is already powered up:

1. Press the Shift key and then the System (8) key.
2. Press the Self Test submenu key. The Self Test results are displayed.
3. Press Esc to continue.
5-9  Updating the LMR Master Firmware

To update your Anritsu instrument firmware, use a high quality USB memory stick with at least 250 MB of free space and FAT32 file system format.

1. Insert the memory stick into your PC or laptop.
2. From a browser, go to the following Anritsu Products page:
3. If the Web page lists more than one product, find your instrument model number and click the link.
4. On the product page, press the Downloads button.
5. Under the Drivers/Firmware/Software tab, you can optionally follow the Firmware Revision/Release History link to download a document detailing current and past firmware changes.
6. Click on the link Firmware Update for the BTS Master MT8220T.
7. Click the Download button, then choose Save or Save As. Do not run the executable file directly from the Web page.
8. Go to the Save location designated in Step 7 and double-click the installer file, or USB Loader.
9. In the Firmware Update dialog, click to view, then accept the software license agreement.
10. Select the Removable Disk drive where the USB stick is inserted.
11. Click Prepare USB Memory Stick to extract and copy the firmware update code.
12. After the firmware update code has finished copying, click through the final steps in the Firmware Update dialog to close the installer program.
13. Eject the memory stick from the computer.

| Note | The file structure created on the USB memory stick by the installer program is necessary for a successful firmware update and must not be altered in any way. |

14. Turn off the BTS Master and insert the USB memory stick into the instrument.
15. Make sure the BTS Master is plugged into an AC power source and not running on battery alone, then turn on the instrument.
16. The instrument should detect new firmware on the USB stick and ask if you wish to upgrade. Press Yes.
17. The Automatic Firmware Update dialog should open at this time. Skip to Step 19.

| Note | If the same firmware code as contained on the USB stick is already loaded on the instrument, a message indicating that firmware update is skipped will display briefly on the instrument screen.  
If the firmware update on the memory stick does not match your instrument model, an error message will display briefly, indicating that it is not compatible. |
18. If there is no error but the instrument does not enter upgrade mode automatically:
   a. Press Shift > System (8) > System Options > Reset > Update Firmware.
   b. Press Load Firmware at the bottom left of the instrument screen.
   c. Press Update Application Firmware.
   d. The Firmware Update dialog opens.
19. Use the Up/Down arrow keys or the rotary knob to select one of the Save modes.
    • Save none: No attempt is made to save any user data.
    • Save user data: User data is saved to the selected external media device.

   **Warning**
   Some user data may be lost if not enough memory space is available on the selected device.

   • Save & restore user data: User data is saved to the selected external media device. The instrument also attempts to restore the files to the instrument after the update.

   **Warning**
   Some user data may be lost if not enough memory space is available on the selected device.

20. Press Enter.
21. Press Enter again to proceed with the firmware upgrade.
    
    To cancel the operation, press Esc. In this case, you need to press Shift > Mode (9) and select an application from the Mode Selector list in order to exit upgrade mode and resume normal instrument operation.

   **Warning**
   You cannot stop the upgrade once it has started. To avoid potential permanent damage, do not turn off the instrument or remove the USB stick during the firmware update.

22. After the update is complete, the instrument should reboot automatically. If it turns off and does not restart, remove the USB stick and turn on the instrument.
Chapter 6 — Ethernet Connectivity

6-1 Introduction

This chapter describes how to connect to a network or directly to a PC using Ethernet Connectivity. It also describes the RJ-45 connector, DHCP, and connection tests for the S412E LMR Master.

6-2 Ethernet Connection

Network Connection

| Note | DHCP is the default Ethernet type. If the Anritsu handheld has been set to Manual, change to DHCP from the System main menu (Shift+8) > System Options > Ethernet. |

Use the following procedure if you can connect to a network that offers DHCP.

1. Connect the handheld instrument and the computer running MST to the Ethernet network.

2. Turn on the Anritsu handheld and confirm the network connection from the System main menu (Shift+8) > Status submenu key. The IP address on the handheld is displayed in the STATUS window.

3. In Master Software Tools, press the Network tab, then the Query Network for Instruments button. Double-click the handheld instrument to complete the connection. The instrument model and IP address along with a green connection icon will be displayed at the top of the MST window.

Ethernet Direct Connection

Use the following procedure if you cannot connect to a network running DHCP.

1. Connect the handheld instrument and the computer running MST with an Ethernet crossover cable or a standard Ethernet cable with a crossover adapter.


3. Use the Field and Octet submenu keys to setup the following:
   - IP: 10.0.0.2
   - Gateway: 10.0.0.2
   - Subnet: 255.255.255.0

   Press Enter to save the changes.

| Note | The following steps may disable network and/or Internet access. |
4. Configure the computer for direct Ethernet connection:
   a. On the computer running MST, double-click on the local area connection
      associated with Ethernet crossover cable connection (Start menu > Settings >
      Network Connections > Local Area Connection x).
   b. Click on the Properties button, then double-click on Internet Protocol (TCP/IP).
   c. Select Use the following IP address (or Alternate Configuration) and enter the
      following information:
         IP: 10.0.0.1
         Gateway: 10.0.0.1
         Subnet: 255.255.255.0
   d. Close all the open windows and restart the computer and the Anritsu
      instrument.

5. Open Master Software Tools, press the Network tab then the Query Network for
   Instruments button. Double-click on the instrument to complete the connection. The
   instrument model and IP address (10.0.0.2) along with a green connection icon will be
   displayed at the top of the MST window.

6-3 Ethernet Configuration

LAN Connection
The RJ-45 connector is used to connect the LMR Master to a local area network. Integrated
into this connector are two LEDs. The amber LED shows the status of the Ethernet Link:
Link Up (On) or Link Down (Off). The green LED flashes to show that LAN traffic is present.
The instrument IP address is set by pressing the Shift key, then the System (8) key followed
by the System Options soft key and the Ethernet Config soft key. The instrument Ethernet
address can be set automatically using DHCP, or manually by entering the desired IP
address, gateway address, and subnet mask.

| Note | An active Ethernet cable may need to be connected to the instrument before it is
turned ON in order to enable the Ethernet port for DHCP or for a static IP address.

   Depending upon local conditions, the port may remain enabled when changing
from DHCP to static IP address, when changing from static IP address to DHCP,
or when temporarily disconnecting the Ethernet cable.

   If the port becomes disabled, ensure that an active Ethernet cable is attached to
the instrument before cycling the power OFF and back ON.

Dynamic Host Configuration Protocol (DHCP) is an Internet protocol that automates
the process of setting IP addresses for devices that use TCP/IP, and is the most common method
of configuring a device for network use. To determine if a network is set up for DHCP, connect
the S412E to the network and select DHCP protocol in the Ethernet Config menu.

Turn the LMR Master off, and then on. If the network is set up for DHCP, the assigned IP
address should be displayed briefly after the power up sequence.
To display the IP address with the instrument on, press the **Shift** key, then the **System** (8) key, then the **System Options** soft key and the **Ethernet Config** soft key. The IP address will be displayed as shown in **Figure 6-1**. The image on the display panel of your LMR Master may differ from the image shown here.

**Figure 6-1.**  IP Address Assigned Using DHCP
Ethernet Config

Press this submenu key to display the Ethernet submenu and to open the Ethernet Editor dialog box in order to set the IP address of the instrument.

Figure 6-2. Setting IP Address Manually
**Ethernet Menu**

Key Sequence: **Shift, System (8) > System Options > Ethernet Config**

<table>
<thead>
<tr>
<th>Type</th>
<th>Manual</th>
<th>DHCP: Press this submenu key to select whether the address will be entered manually, or will be supplied automatically by a network DHCP server. If Manual is selected, then use the submenu keys or the <strong>Left/Right</strong> arrow keys to select the field that is to be modified. Use the keypad, the <strong>Up/Down</strong> arrow keys, or the rotary knob to enter the input. Press <strong>Enter</strong> to accept the changes, or press the <strong>Esc</strong> key to return to normal operation without changing anything.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td></td>
<td><strong>IP</strong> G-Way Sub: Press this submenu key to select the desired Internet Protocol Property to be edited.</td>
</tr>
<tr>
<td>First Octet</td>
<td></td>
<td><strong>First Octet:</strong> Moves the cursor to the left most column of the selected IP properties field.</td>
</tr>
<tr>
<td>Second Octet</td>
<td></td>
<td><strong>Second Octet:</strong> Moves the cursor to the second column from the left of the selected IP properties field.</td>
</tr>
<tr>
<td>Third Octet</td>
<td></td>
<td><strong>Third Octet:</strong> Moves the cursor to the third column from the left of the selected IP properties field.</td>
</tr>
<tr>
<td>Fourth Octet</td>
<td></td>
<td><strong>Fourth Octet:</strong> Moves the cursor to the forth column from the left of the selected IP properties field.</td>
</tr>
</tbody>
</table>

**Figure 6-3.** Ethernet Menu
DHCP stands for Dynamic Host Configuration Protocol. It is a protocol that allows a server to dynamically assign IP addresses to devices that are connected to the network. Most networks include a DHCP server to manage IP addresses. When a DHCP server is available on the network, DHCP is the preferred IP address assignment mode.

When using DHCP, no setup is required to lease and use a dynamic IP address. In a dynamic IP operation, the IP address in use may change from use to use. The DHCP server hands out IP addresses on a first come, first served basis. As soon as the device is disconnected from the network, the IP address that it was using becomes available to lease to the next unit that requests an IP address. Normally, some amount of lag time is present on the DHCP server end, so if the device is connected again reasonably soon, then it may end up with the same address.

When a DHCP server is not available, a static IP address can be used. A static IP address is a fixed address. After being set, it will always remain the same, and care must be taken to not conflict with other equipment on the network.

When using a static IP address on an established network, always request the static IP address from the network administrator. Randomly choosing a static IP address on an established network may result in duplicate IP addresses or other conflicts.

Three parameters must be set prior to using a static IP address:

**IP Address**

This is the static IP address on the network.

**Default Gateway**

Often when a static IP address is assigned, a default gateway is also identified. If the default gateway is unknown, then type in the static IP address so that the static IP address and default gateway are the same number.

**Subnet Mask**

This parameter is usually extracted from the static IP address based on the class of the address and determines the destination of any broadcast messages that might be sent from the instrument. It can be customized if necessary. The subnet mask may also be provided with the static IP address.

---

**Note**

The instrument may need to be connected to the network before it is turned on in order for DHCP to function. Key elements of the DHCP lease are performed during the instrument startup operations or when switching from manual to DHCP, and may not reliably synchronize during normal operation.
Example 1
In this example, a static IP address has been chosen because no network DHCP service is available. The instrument is connected to the network port on the PC with a crossover Ethernet cable (not included). This is also referred to as Direct Connect:

- IP Address: 10.0.0.2
- Default Gateway: 10.0.0.1
- Subnet Mask: 255.255.0.0

Example 2
In this example, the static IP address has been assigned with an associated gateway and subnet mask:

- IP Address: 153.56.100.42
- Default Gateway: 153.56.100.1
- Subnet Mask: 255.255.252.0

6-5 ipconfig Tool
A few tools that are built into the Microsoft Windows operating system can assist in making some determinations about the network to which the PC is connected. Typing `ipconfig` at a command prompt produces a display of information about the in-use parameters of the PC and its network connection. Following is an example of the typical results expected:

```
Y:/>ipconfig
Windows 2000 IP Configuration
Ethernet adapter Local Area Connection:
 Connection-specific DNS Suffix. : us.anritsu.com
 IP Address. . . . . . . . . . . . . : 172.26.202.172
 Subnet Mask . . . . . . . . . . . . : 255.255.252.0
 Default Gateway . . . . . . . . . : 172.26.200.1
```

Note
The ipconfig display does not report whether the information is from a DHCP server or from a static IP setup.
6-6 Ping Tool

Another tool that can find out if a selected IP address is already on the network is ping. Ping is a harmless way to determine if an address is found on the network, and (if it is found) to receive a reply. Basically, the ping function sends out a request to a specific address to determine if a computing device is connected to the network at that address. If a valid connection is found, then a copy of the signal (that was sent) is returned. If a connection is not found, then the response is “request timed out”, which means that no reply was received from that IP address.

Pinging 172.26.202.172 with 32 bytes of data:
Reply from 172.26.202.172: bytes=32 time<10ms TTL=128
Reply from 172.26.202.172: bytes=32 time<10ms TTL=128
Reply from 172.26.202.172: bytes=32 time<10ms TTL=128
Reply from 172.26.202.172: bytes=32 time<10ms TTL=128
Ping statistics for 172.26.202.172:
Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
Approximate round trip times in milliseconds:
Minimum = 0 ms, Maximum = 0 ms, Average = 0 ms
Chapter 7 — Anritsu PC Software Tools

7-1 Introduction

This chapter provides a brief overview of the available PC software tools from Anritsu. For detailed information about specific software, refer to the Anritsu web site or the program’s built-in Help. Software is included with the instrument and is also available from the Anritsu web site: http://www.anritsu.com/en-US/Services-Support/Handheld-Tools-Tool-Box.aspx.

7-2 Anritsu Tool Box

The Anritsu Tool Box is a central location to open an Anritsu measurement, visit the Anritsu web site, or launch several Anritsu applications. To open the Anritsu Tool Box, either click on the shortcut icon on the desktop or click Start and navigate through the Programs folder to the Anritsu folder and select Anritsu Tool Box.

Once the tool box is open, move the mouse pointer over any of the application icons to view a short description of the application. The following pages describe the software programs that can be launched from the Anritsu Tool Box.

Figure 7-1. Anritsu Tool Box
7-3 Line Sweep Tools

Line Sweep Tools is a program designed to increase productivity for people who work with dozens of Cable traces, Antenna traces, and Passive Intermodulation (PIM) traces every day. Line Sweep Tools will:

- Collect sweeps from Anritsu PIM and Line Sweep gear.
- Help verify that those sweeps are done properly and that the Cable, Antenna and PIM sweeps meet specifications.
- Help create reports of the findings quickly and to a professional standard.

The Anritsu PC Software tools do not support all of Anritsu’s handheld instruments or all of their measurements. Compatibility information is provided in the program’s Help.

Note

Line Sweep Tools (LST) can be used for downloading and post-processing of certain VNA measurements and cable & antenna analysis sweeps.

Master Software Tools (MST) is primarily used for spectrum analysis measurements.

Figure 7-2. Line Sweep Tools
7-4 Master Software Tools

Anritsu Master Software Tools is a PC program for transferring and editing saved measurements, markers, and limit lines to a PC. MST is recommended for Spectrum Analyzer instruments or instruments that perform spectrum analysis measurements.

Figure 7-3. Master Software Tools
easyTest Tools

easyTest Tools is used to create work instruction files that consist of a command sequence and instructions to help less experienced personnel with operating the instrument in the field.

- A drag-and-drop tool facilitates the creation of a test sequence from a library of commands.
- Instructions can be a mix of textual prompts and graphic images.
- Sample procedure files (.ett) are included with easyTest Tools.
- Command sequences are delivered electronically and loaded on the instrument, where they are recalled with a press of a button.
- Recall Setup places the instrument in the proper mode for the measurement by retrieving saved parameters such as measurement type, frequency and amplitude settings, markers and limit lines.

The current measurement setup or the screen display can be saved manually or automatically.

easyMap Tools

easyMap Tools creates geo-referenced maps and can also convert floor plans for use by Anritsu mapping spectrum analyzers. It can also create single panel maps (.map) for legacy instruments or pan and zoom maps (.azm) for current instruments. Mapping of both interference and coverage is available while indoors or outdoors.

Figure 7-4. Captured Geo-referenced Map Ready for the Analyzer
Chapter 8 — Bias Tee (Option 10)

8-1 Overview

Option 10 provides a bias tee that is installed inside the instrument. The bias arm is connected to a 12 VDC to 32 VDC power source that can be turned on as needed to place the voltage on the center conductor of the VNA Port 2 (in VNA mode) or the center conductor of RF IN (in SPA mode). This supply of bias is useful when conducting two-port transmission measurements and can also be used to provide power to block down-converters in satellite receivers or to power some tower-mounted amplifiers (TMAs).

Bias Tee in VNA Mode

The bias can be turned on only when the Start Frequency is 2 MHz or greater. When bias is turned on, the bias voltage and current are displayed in the Instrument Settings Summary area of the screen. The 12 VDC to 32 VDC power supply is designed to continuously deliver a maximum of 6 watts.

When in VNA mode, the bias tee menu can be accessed as follows:

- From the Sweep menu when in standard VNA mode:
  
  Key Sequence: **Sweep** > Configure Ports > Bias Tee Setup

- From the System Options menu when VNA Field menus are selected:
  
  Key Sequence: **Shift, System (8)** > Application Options > Bias Tee Setup

![Bias Tee Menu](image)

**Figure 8-1.** Bias Tee Menu

**Bias Tee**: Toggles On and Off the variable power supply.

**Int Voltage P2**: Use this submenu to set the power supply voltage.

**Int Current Limit P2**: Use this submenu to set the power supply current.

**Back**: Press this submenu key to return to the Configure Ports menu.
Figure 8-2 shows how the LMR Master provides an internal voltage between 12 volts and 32 volts that is applied to the center conductor of Port 2. That voltage would be available at the port along with the RF signals.

Figure 8-2. Bias Tee Setup in VNA Mode

Additional information for Option 10 is provided in the Vector Network Analyzer Measurement Guide (refer to Appendix A).
**Bias Tee in SPA Mode**

When bias is turned on, the bias voltage and current are displayed in the Instrument Settings Summary area of the window. The 12 VDC to 32 VDC power supply is designed to continuously deliver a maximum of 6 watts.

The bias tee menu can be accessed from the Application Options menu in SPA mode:

**System > Application Options > Bias Tee**

<table>
<thead>
<tr>
<th>Bias Tee</th>
<th>Toggles On and Off the variable power supply.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bias Tee Voltage</td>
<td>Use this submenu to set the power supply voltage.</td>
</tr>
<tr>
<td>Current</td>
<td>Toggle the bias tee current between Low and High.</td>
</tr>
<tr>
<td>Back</td>
<td>Press this submenu key to return to the Application Options menu.</td>
</tr>
</tbody>
</table>

**Figure 8-3. Bias Tee Menu**
Figure 8-4. Bias Tee Setup in SPA Mode
Chapter 9 — GPS (Option 31)

9-1 Introduction

The LMR Master is available with a built-in GPS receiver feature (Option 31) that can provide latitude, longitude, altitude, and UTC timing information. This option also enhances the frequency reference oscillator accuracy in the Spectrum Analyzer mode. Within three minutes of satellite acquisition, the reference oscillator will have an accuracy of better than 50 ppb (parts per billion).

In order to acquire data from the GPS satellites, you must have line-of-sight to the satellites, or the antenna must be placed outside without any obstructions. An Anritsu GPS antenna is required.

Note
The LMR Master Technical Data Sheet provides a list of options and the measurements that require GPS (Option 31).

9-2 Activating the GPS Feature

Install the Anritsu GPS antenna onto the GPS Antenna connector on the LMR Master.

1. Press the Shift key, then the System (8) key.
2. Press the GPS submenu key.
3. Press the GPS On/Off submenu key to toggle the GPS feature on or off. When GPS is first turned on, a RED GPS icon appears at the top of the display.

Figure 9-1. GPS Icon, Red
4. When the GPS receiver has tracked at least three satellites, the GPS icon changes to GREEN. Latitude and Longitude information is displayed in the white bar on top of the display. Acquiring satellites may take as long as three minutes.

5. Press the GPS Info submenu key to view information about:
   - Tracked Satellites
   - Latitude and Longitude
   - Altitude
   - UTC
   - Fix Available
   - Almanac Complete
   - Antenna and Receiver Status
   - GPS Antenna Voltage and Current

   Refer to Section 9-4 “GPS Menu” on page 9-3 for details about the GPS Info dialog box.

6. Press the Reset submenu key to reset the GPS.

7. The GREEN GPS icon with a RED CROSS through it, as shown below, appears when GPS satellite tracking is lost (after actively tracking 3 or more satellites). The GPS longitude and latitude are saved in the instrument memory until the LMR Master is turned off or until GPS is turned off by using the GPS On/Off key.
9-3  Saving and Recalling Traces with GPS Information

Saving Traces with GPS Information

The GPS coordinates of a location can be saved along with a measurement trace. Refer to the “Save Menu” on page 4-9 for more information. The current GPS coordinates are saved with the measurement traces whenever GPS is on and actively tracking satellites.

Recalling GPS Information

If the GPS coordinates were saved with a measurement, then when the measurement is recalled, the coordinates that were saved are recalled as well. Refer to the “Recall Menu” on page 4-12 for more information about recalling a saved trace.

9-4  GPS Menu

Key Sequence:  Shift, System (8) > GPS

<table>
<thead>
<tr>
<th>GPS</th>
<th>GPS Info</th>
<th>GPS Voltage</th>
<th>Reset</th>
<th>Back</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>On</td>
<td>3.3 V</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Off</td>
<td>Off</td>
<td>5 V</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

GPS:  Press this submenu key to turn GPS on or off.

GPS Info: Press this submenu key to display the current GPS information. Refer to “GPS Info” on page 9-4.

GPS Voltage: Press this submenu key to set the source voltage to be either 3.3 V or 5 V depending on the GPS receiver being used. GPS antenna voltage is set to 3.3 V by default in order to prevent accidental damage to lower-voltage GPS antennas. 5 V is the recommended setting for Anritsu GPS antennas.

Reset: Press this submenu key to set the number of tracked satellites to 0 and to erase any almanac data, along with saved coordinates. The process of searching for and reacquiring satellites begins again.

Back: Press this submenu key to return to the “System Menu” on page 5-4.

Figure 9-4.  GPS Menu
GPS Info

- **Tracked Satellites**
  Shows the number of tracked satellites (three are required to retrieve latitude and longitude, four are required to resolve altitude). Generally, the larger number of satellites tracked, the more accurate the information.

- **Latitude and Longitude**
  Shows location in degrees, minutes, and seconds.

- **Altitude**
  Shows altitude information in meters.

- **UTC**
  Universal Coordinated Time.

- **Fix Available**
  The cold start search sets are established to ensure that at least three satellites are acquired within the first couple of minutes. When three satellites are found, the receiver computes an initial fix (typically in less than two minutes). **Fix Not Available** means that the initial position has not been established.

- **Almanac Complete**
  The system Almanac contains information about the satellites in the constellation, ionospheric data, and special system messages. In a cold start, the GPS receiver does not have any navigation data so the receiver does not have a current almanac. A complete system almanac is not required to achieve a first position fix. The availability of the almanac, however, can significantly reduce the time to first fix.

- **Antenna Status**
  **OK:** Antenna is connected properly and antenna is working properly
  **Short/Open:** A short or open exists between the antenna and the connection. If this message is displayed, then remove and replace the GPS antenna. If the message persists, then try another Anritsu GPS antenna. If the message persists, contact your nearest Anritsu Service Center.

- **Receiver Status**
  Current status of the receiver.

- **GPS Antenna Voltage and Current**
  Shows voltage and current.
Chapter 10 — Web Remote Control

10-1 Introduction

Web Remote Control capabilities are embedded in the LMR Master, providing full instrument control through an HTML-5 compatible browser. Ethernet is required. The ability to remotely monitor and control the instrument from the ground or desk enhances operator safety and efficiency when conditions make it unsafe or impractical to be close to the instrument. Login passwords can be used to allow access to authorized users only.

A remote connection terminates when the user logs out or closes the browser, or when the session time requested at login expires. To prevent multi-user conflicts, only one connection is permitted at a time. A second user who tries to log in will see a message indicating the instrument is currently reserved by another client, with the time remaining in their session.

While only one user can have control of the instrument, multiple users can view the same instrument using a desktop sharing application.

10-2 Setup

You can connect one or more instruments to any computer with HTML-5 compatible browser. Anritsu strongly recommends using Google Chrome, as other browsers do not fully support HTML-5. The control device may be a laptop, a desktop computer, or a mobile device, including a wide range of tablets and smart phones running Android or iOS operating systems. Note that you cannot download files to an iOS device, for lack of a user-accessible file system in this environment.

Physical connection is established from the instrument’s Ethernet port directly to the computer, or to a LAN or a portable Wi-Fi router such as the ZyXEL MWR102 Portable Router.

LAN Connection

1. Connect the Ethernet port of the LMR Master to your LAN.
2. Press Shift followed by System (8).
3. Press the Status submenu key to display the Status window and take note of the instrument IP address.
   - Press Esc to close the Status window.
4. If no IP address has been assigned, refer to Appendix 6, “Ethernet Connectivity” for information on setting an IP address for the instrument. If connecting to another network, we recommend that you request a static IP address from your network administrator to avoid duplicate addresses.
   - Alternatively, you can set the instrument for dynamic IP addressing using DHCP. Refer to “Ethernet Menu” on page 6-5. In a long distance network, however, it may be difficult or impossible to determine what the current dynamic address is, after the instrument is in the field.
5. Set instrument parameters as appropriate, such as measurement mode, frequency range, amplitude. You may skip this step and set up the instrument remotely at a later time, after Ethernet connection has been established.

6. Launch the Google Chrome browser on your PC, laptop, or mobile device. Due to compatibility issues with HTML-5, do not connect using another browser than Chrome.

7. Enter the instrument IP address in the browser address bar to open the Web Remote Control Login page illustrated in Figure 10-1 on page 10-3.

**Connection to a Wi-Fi Portable Router**

Instead of connecting the instrument directly to a LAN, you can connect it to a Wi-Fi router. This section documents connection to the ZyXEL MWR102 Portable Router as an example.

1. Take note of the router’s SSID and pre-programmed password, which are found on a sticker affixed to the router.

2. Using the Ethernet cable included with the router, connect one end to the black LAN port and the other end to the test instrument’s Ethernet port.

3. Insert the Mini-B (small) end of the provided USB cable into the router and the Type-A (larger) end of the cable into one of the USB ports of your test instrument.

4. Optionally, secure the router to the instrument body using a strip of Velcro or other hook-and-loop fastener. You may also place the router in the instrument carrying case, if it fits.

5. Use your computer’s Wi-Fi Network Connection utility to find the router. With the ZyXEL MWR102 Portable Router, the SSID name will be ZyXEL followed by an alphanumeric string unique to your particular router.

6. Connect to this SSID. When prompted, enter the router password noted in Step 1.

7. Set the IP address manually on the instrument. Refer to “Ethernet Menu” on page 6-5.

8. Launch the Google Chrome browser on your PC, laptop, or mobile device. Due to compatibility issues with HTML-5, do not connect using another browser than Chrome.

9. Enter the instrument IP address in the browser address bar to open the Web Remote Control Login page illustrated in Figure 10-1 on page 10-3.
10-3 Web Remote Control Interface

The Web Remote Control Login page opens following browser connection to the instrument. See Figure 10-1. The page may show or hide certain elements depending on device management options set by the Administrator, as described in “Device Options” on page 10-12.

User Login

To start a remote session with a test instrument:

1. Enter the instrument IP address in the Google Chrome address bar. The instrument must be connected via Ethernet as described in “Setup” on page 10-1.

2. Use the pull-down menus on the Login page to set the time, in hours and minutes, before the remote session times out. The default session time is 1 hour, with a 10-hour maximum.

   Only one user at a time can connect to the instrument. To avoid locking out other users unnecessarily, do not reserve a longer session than you need.

3. To enable functions available only to the network administrator, select the Login as Administrator checkbox.

4. Enter the instrument password, then click Login.

   The default administrator password is “Admin” with a capital A. The default password for other users is None; that is, leave the field blank.

If another user already has control of the instrument when you try to log in, a message will display indicating the instrument is currently reserved by another client, whose IP address is listed with the time remaining in their session.

Following login, the Web Remote Control Home page is displayed.
The Web Remote Control Home page lists the same information as what is displayed on the instrument screen when you press **Shift, System (8)** at the front panel, followed by the **Status** menu key.

At the top of the page, a green banner shows the instrument model number and IP address. If the instrument has been assigned a name, this name is displayed in the center of the banner.

The menu bar below the banner consists of tabs for commands and links: Home, Remote Control, Capture Screen, Capture Trace, File List, Device Management, and Logout.

**Figure 10-2.** Web Remote Control Home Page
Remote Control

The Remote Control page displays a bitmap image of the instrument screen. The buttons on the right of the display reflect the layout of the buttons on the instrument and are used to access the same monitoring and control functions. See Figure 10-3.

![Remote Control Page](image)

**Figure 10-3.** Remote Control Page

**Notes**

- When clicking a key or measurement icon on the Remote Control page, a small green dot appears at the point of the cursor to indicate that the key, button, or icon was pressed.
- A single Web-enabled device can monitor and control multiple instruments. However, multiple Web-enabled devices with different IP addresses cannot connect to the same instrument simultaneously.

**Session Time Remaining**

This is the amount of time remaining before your remote session automatically terminates. The session time is reserved at login. It can be changed on the Device Management page.
Normal Mode

Normal Mode is the default mode, where the bitmap image of the instrument screen is continually refreshed in the browser window. Click the single arrow button near the bottom right of the page to return to Normal Mode from either Fast or Pause Mode. Clicking any tab on the menu bar also returns to Normal Mode.

Fast Mode

Click the double arrow button to enter Fast Mode, where the update rate can be significantly faster than Normal mode, especially over low bit-rate connections. Only the measurement data (yellow trace) is continually updated. The main menu keys and submenu keys may look different than in Normal Mode, but their functions are the same. Error messages are not shown in Fast Mode.

Fast Mode is not available with some Spectrum Analyzer measurement types, in which case the Fast Mode button is disabled. The button is not displayed when the measurement mode is something other than Spectrum Analyzer.

While in Fast mode, if a measurement type is selected that Fast mode does not support, the instrument will return to Normal mode.

Pause Mode

Clicking the Pause button turns the Communication Activity dot in the lower right-hand corner to yellow. If the interface was in Normal Mode, this stops the instrument display from refreshing in the browser window. If the interface was in Fast Mode, the trace measurement stops updating. Click the single arrow or the double arrow button to resume remote communications with the instrument in Normal or Fast Mode, respectively. The Communication Activity dot then returns to green.

Communication Activity

The moving dot labeled Communication Activity, when green, indicates that ongoing communication is occurring between the instrument and PC. When you click Home, Capture Screen, Capture Trace, File List, Device Management, or Logout on the menu bar, the Communication Activity dot briefly turns yellow before the selected page opens in the browser.

Configure Timeout

If the Ethernet connection is poor and you expect frequent lags in response time, you can increase the timeout up to 20 seconds, before the instrument sends an “Instrument Busy” message. The default timeout is 3 seconds.
Capture Screen

Captures a JPEG image of the current instrument display and saves it directly to internal memory. A file name is automatically created using the current date and time stamp. The captured display is loaded to the browser page, under the menu bar. See Figure 10-4. In Windows, you can right-click on the screen image and select Copy. With iOS, press and hold on the picture. This makes it easy to create documentation using screen captures.

Figure 10-4. Capture Screen Page

Capture Trace

Opens an input dialog to enter a name for the trace to be saved. See Figure 10-5. After clicking Save, a confirmation dialog opens to indicate the trace was successfully saved to the instrument.

Figure 10-5. Capture Trace Page

Depending on the browser and operating system used, different prompts may appear. Some operating systems like iOS may not support file saving from a browser.
File List
Displays the list of folders (type “dir”) and files contained in the instrument's internal memory. See Figure 10-6. To view the contents of a folder, click on the folder name. To download a file, click the file name. Alternatively, you can select the checkbox on the left of the file name, then click Download. You may also select the checkboxes of multiple files and/or folders and download them together, as a zipped folder. In this case, a pop-up dialog box shows the estimated download time. Press OK to continue.

Note: Some operating systems, like iOS, do not support file downloads.

Depending on the browser and operating system, the download function may allow you to open the file or save it, or both. In Google Chrome, for example, the downloaded file or files are automatically saved to the designated folder on your computer, such as the Downloads folder. In the banner at the bottom of the browser window, click a downloaded item to open it.

If the selected item is a single file, the file will open in the default application for the file type. For example, a JPEG file will open in the computer's default image viewer, while a measurement file will open in Master Software Tools (MST), provided the application is installed.

Device Management (not as Administrator)
Click the Device Management tab on the menu bar to set or clear the instrument password, to assign a device name to the instrument, or to change the session time. See Figure 10-7.

If you logged in as Administrator, the Device Management page has additional sections for viewing the remote access log and for setting device options. Refer to “Device Management (Administrator)” on page 10-11.
Password

If no password is set, which is the factory default, remote access to the instrument is unrestricted and any user who knows the instrument IP address can connect to it, provided the device isn't currently reserved by another client. When a password is set, it is required upon login. To clear the current password, click the Reset button. This password is different from the administrator password described under “Device Management (Administrator)”.

Instrument Name

The instrument name, if defined, is displayed in the green banner at the top of the page. It is useful in identifying the instrument when you have more than one instrument connected. The name can be assigned remotely from this Device Management page, or it can be set from the instrument's System Options menu. Note that this instrument name is not a "hostname" as used in an Ethernet router.
Session Time

Use the pull-down menus to select the time, in hours and minutes, before the remote session times out. Click Update to reset the session timer at the specified duration. At the end of the selected time period, a message notifying the user that the session has expired will display.

Figure 10-8. Session Expired
Device Management (Administrator)

Logging in as Administrator gives you access to additional functions associated with the instrument’s remote connection log and the display of information on the Login page.

Figure 10-9.  Device Management Page (Administrator)
Administrator Password

A password is always required to log in as Administrator. The password is case-sensitive, with “Admin” as the factory default. To change the password, type your new entry twice and click Save. See Figure 10-9 on page 10-11.

To restore the default password, click the Reset button. The administrator password is also reset to default each time you update the instrument firmware.

Access Log

The Access Log is viewable only when you are logged in as Administrator. It contains the date and time, success or failure status, and user information for up to 50 most recent login attempts. To save a copy of the log to the default download location on your control device, click Download Log. The saved file is a comma-delimited CSV file that can be opened with an application like Microsoft Excel. Click the Clear Log button to empty the Access Log.

Device Options

When logged in as Administrator, you have the option to turn on or off the optional text message and the green banner on the Login page.

For security reasons, for example, you may not want the instrument IP address to display during login. To hide the banner, deselect the Show device banner on Login page checkbox. See Figure 10-9 on page 10-11. After changing the Show/Hide setting, click OK in the Banner Visibility message box. You may need to scroll the browser page to bring the message box into view.

The factory default is to show the banner. Note that this device option only affects the Login page. Figure 10-10 illustrates the Login page with no banner.

![Login Page with Optional Text and No Banner](image)

Figure 10-10. Login Page with Optional Text and No Banner

Note

Some operating systems, such as iOS, do not support a user-accessible file system. Consequently, the download function is not possible if your control device is an Apple iPhone, for example.
To add a disclaimer or any other message to the Login page, enter the appropriate text in the text box under the Device Options section of the Device Management page, then click Save. See Figure 10-9 on page 10-11. Click OK in the update status message box (Figure 10-11). You may need to scroll the browser page to bring this message box into view.

![New disclaimer text successfully updated](image)

**Figure 10-11.** Disclaimer Text Update Status

Figure 10-10 on page 10-12 shows an example of optional text on the Login page. To remove the message, delete it from the Disclaimer Text box on the Device Management page and click Save, then OK.

**Instrument Name**

The instrument name function is the same whether you are logged in as Administrator or as a regular user. Refer to “Instrument Name” on page 10-9.

**Session Time**

The session time is set in the same manner, whether you are logged in as Administrator or as a regular user. Refer to “Session Time” on page 10-10.

**Logout**

Exits Web Remote Control and displays the Login page. To start a new session, enter the password if required, then select the session time and click Login.

**Note**

If you close the Web Remote Control browser window without logging out, there may be a slight delay before the instrument is released. During this time, connection attempts by other users will fail.
### Appendix A — Measurement Guides

#### A-1 Introduction

This appendix provides a list of supplemental documentation for LMR Master features and options. Measurement guides are available as PDF files on the documentation disc and the Anritsu Website (http://www.anritsu.com).

<table>
<thead>
<tr>
<th>LMR Master Feature (Available Option)</th>
<th>Document and Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>LMR Master Instrument</td>
<td>Important Product Information, Compliance, and Safety Notices (10100-00065)</td>
</tr>
<tr>
<td>Performance Specifications</td>
<td>LMR Master Technical Data Sheet (11410-00486)</td>
</tr>
<tr>
<td></td>
<td>Land Mobile Radio Measurement Guide (10580-00243)</td>
</tr>
<tr>
<td>NBFM Analyzer</td>
<td></td>
</tr>
<tr>
<td>P25/P25p2 Analyzer (Option 521)</td>
<td></td>
</tr>
<tr>
<td>P25/P25p2 Coverage (Option 522)</td>
<td></td>
</tr>
<tr>
<td>NXDN Analyzer (Option 531)</td>
<td></td>
</tr>
<tr>
<td>NXDN Coverage (Option 532)</td>
<td></td>
</tr>
<tr>
<td>dPMR Analyzer (Option 573)</td>
<td></td>
</tr>
<tr>
<td>dPMR Coverage (Option 572)</td>
<td></td>
</tr>
<tr>
<td>DMR Analyzer (Option 591)</td>
<td></td>
</tr>
<tr>
<td>DMR Coverage (Option 592)</td>
<td></td>
</tr>
<tr>
<td>PTC Analyzer (Option 721)</td>
<td></td>
</tr>
<tr>
<td>PTC Coverage (Option 722)</td>
<td></td>
</tr>
<tr>
<td>TETRA Analyzer (Option 581)</td>
<td></td>
</tr>
<tr>
<td>TETRA Coverage (Option 582)</td>
<td></td>
</tr>
<tr>
<td>Spectrum Analyzer</td>
<td></td>
</tr>
<tr>
<td>Interference Analyzer (Option 25)</td>
<td>Spectrum Analyzer Measurement Guide (10580-00349)</td>
</tr>
<tr>
<td>Channel Scanner (Option 27)</td>
<td></td>
</tr>
<tr>
<td>Coverage Mapping (Option 431)</td>
<td></td>
</tr>
<tr>
<td>AM/FM/PM Analyzer (Option 509)</td>
<td></td>
</tr>
<tr>
<td>EMF Measurements (Option 444)</td>
<td></td>
</tr>
<tr>
<td>Vector Network Analyzer</td>
<td></td>
</tr>
<tr>
<td>VNA Bias-Tee (Option 10)</td>
<td>Vector Network Analyzer Measurement Guide (10580-00289)</td>
</tr>
<tr>
<td>Vector Voltmeter (Option 15)</td>
<td></td>
</tr>
<tr>
<td>Distance Domain</td>
<td></td>
</tr>
<tr>
<td>High-Accuracy Power Meter (Option 19)</td>
<td>Power Meter Measurement Guide (10580-00240)</td>
</tr>
<tr>
<td>LTE RF Measurements (Option 541)</td>
<td></td>
</tr>
<tr>
<td>LTE Modulation Quality (Option 542)</td>
<td></td>
</tr>
<tr>
<td>LTE OTA Measurements (Option 546)</td>
<td></td>
</tr>
<tr>
<td>LTE 256QAM Demodulation Measurements (Option 886)</td>
<td>3GPP Signal Analyzer Measurement Guide (10580-00234)</td>
</tr>
<tr>
<td>GSM/GPRS/EDGE Measurements (Option 880)</td>
<td></td>
</tr>
<tr>
<td>EMF Measurements (Option 444)</td>
<td></td>
</tr>
</tbody>
</table>
A-1 Introduction

Measurement Guides

A complete suite of computer software applications are available for download:

<table>
<thead>
<tr>
<th>LMR Master Feature (Available Option)</th>
<th>Document and Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed WiMAX RF Measurements (Option 46)</td>
<td>WiMAX Signal Analyzer Measurement Guide (10580-00236)</td>
</tr>
<tr>
<td>Fixed WiMAX Demodulation (Option 47)</td>
<td></td>
</tr>
<tr>
<td>Mobile WiMAX RF Measurements (Option 66)</td>
<td></td>
</tr>
<tr>
<td>Mobile WiMAX Demodulation (Option 67)</td>
<td></td>
</tr>
<tr>
<td>Mobile WiMAX Over-the-Air Measurements (Option 37)</td>
<td></td>
</tr>
<tr>
<td>SCPI Programming Manual</td>
<td>LMR Master Programming Manual (10580-00319)</td>
</tr>
</tbody>
</table>

Table A-1. Measurement Guides for Analyzers and Analyzer Options (2 of 2)
Appendix B — Error Messages

B-1 Introduction

This appendix provides a list of information and error messages that could be displayed on the LMR Master. If any error condition persists, contact your local Anritsu Service Center.

B-2 Reset Options

You can reset your LMR Master to Factory Defaults or use a Master Reset to return to the FULL Factory Default condition from the menu system or from the Off condition.

Reset Via Instrument Menus

From the LMR Master menu system, press the Shift key, then the System (8) key to open the System menu. Then press the System Options submenu key to open the System Options menu. Then press the Reset submenu key to open the Reset menu (refer to “Reset Menu” on page 5-17). From the Reset menu, press either the Factory Defaults submenu key or the Master Reset submenu key.

Reset from OFF Condition

You can also reset the LMR Master by turning it Off and then restarting under one of the following conditions:

Factory Defaults Reset:

Hold the Esc button while pressing the On/Off button. Continue holding the Esc button until the Anritsu splash screen appears. You can then release the button. The LMR Master starts up with many Factory Default settings (refer to “Factory Defaults” on page 5-17). Throughout this appendix, this sequence is abbreviated as Factory Defaults (Esc+On).

Master Reset:

Hold the 8 key in the number keypad (also referred to as the System (8) key) while pressing the On/Off button. Continue holding the 8 key until the Anritsu splash screen appears. You can then release the key. The LMR Master starts up in FULL Factory Default condition (refer to “Master Reset” on page 5-17). Throughout this appendix, this sequence is abbreviated as Master Reset (System+On).
To run self test, press **Shift** and **System (8)** and then **Self Test**. Refer to the results window in **Figure B-1**, which summarizes the status of several key functions in the instrument that are common to all applications (note that your instrument display may differ from this image). If any subtest shows FAILED, then check that the battery level is adequate for operation, or check that the temperature is within acceptable limits. Reset to factory defaults with either **Factory Defaults** (**Esc + On**), or **Master Reset** (**System + On**).

**Caution** Use of Master Reset (**System + On**), will erase all user saved setups and measurement traces and will return the LMR Master to a full Factory Default condition. If the error persists, contact your Anritsu Service Center.
Application Self Test

VNA Mode Self Test (Vector Network Analyzer mode only)

To run the application self test, press **Shift** and **System** (8) and then Application Self Test from within the desired mode. When you are in Vector Network Analyzer mode, you will see the results window that is shown in Figure B-2 (note that your instrument display may differ from this image), which summarizes the status of several key functions that are specific to this application.

![Application Self Test](image)

Figure B-2. Application Self Test

If the Overall Status shows Failed, then one or more elements of the Application Self Test have failed. This self test consists of 2 subtests:

- **Frequency Sweep:** Lists any frequency range over which errors in the sweep are occurring
- **EEPROM:** Indicates whether reading or writing (or both) to the EPPROM has failed

If any of the subtests shows FAILED, then check that the battery level is adequate for operation or that temperature is within acceptable limits. Reset to factory defaults with either **Factory Defaults** (**Esc+On**), or **Master Reset** (**System+On**).

**Caution**

Use of Master Reset (**System+On**), will erase all user saved setups and measurement traces and will return the LMR Master to a full Factory Default condition. If the error persists, contact your Anritsu Service Center.
### Spectrum Analyzer Mode Self Test

![Application Self Test](image1)

**APPLICATION SELF TEST**
- Overall Status: PASSED
- ADC Self Test PASSED
- Mixer Temperature: 43°C
- DSP FPGA Version: 1.13
- SPA FPGA Version: 1.14

**Figure B-3.** Application Self Test

### CW Signal Generator Mode Self Test

![Application Self Test](image2)

**APPLICATION SELF TEST**
- Overall Status: PASSED
- Sys PLL: PASSED
- ID PLL: PASSED
- LO PLL: PASSED
- VR PLL: PASSED
- SigGen FPGA Ver: 1.01
- SigGen: PASSED
- SigGen Level: 8.4 dB
- SigGen Freq: 832.3 Hz
- SigGen PP: 1483.174 mV
- Level Cal Ver: 1

**Figure B-4.** Application Self Test
NBFM, P25/P25p2, NXDN, dPMR, DMR, PTC, and TETRA Self Test

Figure B-5. Application Self Test
**Fan Failure**

The system has determined that the fan should be running due to the internal temperature of the unit, but cannot detect that the fan is actually running.

It is important to keep the fan inlet and exhaust ports clear of obstructions. The cooling fan will vary the speed in relation to the internal temperature of the instrument (refer to Figure B-6). The fan will turn on at low speed when the internal temperature of the instrument reaches 44°C, and will increase the fan speed to maximum at 54°C. As the internal temperature of the instrument decreases, the fan will reduce speed until the temperature reaches 39°C, at which point the fan will turn off.

**High Temp Warning**

The internal temperature has reached an excessive level, 85°C. Verify that the ventilation openings are unobstructed and that the fan is running. Internal temperatures may be manually verified by using the SELF TEST function. Turn off the unit and allow the temperature to cool down. If the fault is not resolved and the internal temperature reaches 90°C, then a countdown of 10 seconds will begin. The countdown gives the user a chance to save the current setup before the instrument turns itself off (before internal temperatures can cause any damage). If the error persists after removing any obstructions and allowing the unit to cool, then reset to the factory defaults with Factory Defaults (Esc + On), or Master Reset (System + On).

**Caution** Use of Master Reset (System + On), will erase all user saved setups and measurement traces and will return the LMR Master to a full Factory Default condition. If the error persists, contact your Anritsu Service Center.
Operation not Permitted in Recall Mode
Attempted to perform an operation on a recalled trace. Many operations are valid only on a live or active trace.

Power Supply
Power Supply failed. Charge the battery.

Error Saving File. General Error Saving File
An error was detected while saving a file. Try again.
Appendix C — Tower Mounted Amplifiers

C-1 Introduction

A Tower Mounted Amplifier (TMA) can be used to amplify the received signal. There are different types of TMA depending on the system requirements. Three commonly used types are:

- TMA-D: A duplex tower mounted amplifier that combines transmit and receive ports from the radio system and connects to a single antenna. This configuration is specific to systems that use a single antenna configuration.
- TMA-S: A receive-only tower mounted amplifier is installed between the receiving antenna and the radio to boost weak signals. This configuration is common on systems that implement separate antennas for transmitting and receiving.
- TMA-DD: A dual-duplex tower mounted amplifier used for radios systems with a single transmission line connection for transmit and receive. These systems are commonly called transceivers.

Figure C-1. Tower Mounted Amplifiers
Appendix D — Glossary of Terms

D-1 Introduction
The following terms are related to this product and its technology.

D-2 Glossary of Terms

3GPP : The 3rd Generation Partnership Project (3GPP) is a collaboration agreement that was established in December, 1998. It is a co-operation between ETSI (Europe), ARIB/TTC (Japan), CCSA (China), ATIS (North America), and TTA (South Korea). The scope of 3GPP was to make a globally applicable third generation (3G) mobile phone system specification within the scope of the ITU’s IMT-2000 project. 3GPP specifications are based on the evolved GSM specifications, now generally known as the UMTS system.

Adapter : A fitting that supplies a passage between two sets of equipment when they cannot be directly interconnected.

Adaptive Array Antenna : Adaptive array antenna is a type of advanced 'smart' antenna technology that continually monitors a received signal and dynamically adapts signal patterns to optimize wireless system performance. The arrays use signal processing algorithms to adapt to user movement, to changes in the radio-frequency environment, and to multi-path and co-channel interference.

ADC : Analog-to-Digital Converter (ADC, A/D or A to D) is an electronic device that converts continuous signals to discrete digital numbers. The reverse operation is performed by a digital-to-analog converter (DAC). ADC can uniquely represent all analog input values within a specified total input range by a limited number of digital output codes. Refer also to DAC.

Adjacent Channel : Adjacent Channel is a channel or frequency that is directly above or below a specific channel or frequency. First-adjacent is immediately next to another channel, and second-adjacent is two channels away, and so forth. Information on adjacent channels is used in keeping stations from interfering with one another.

Adjacent channel interference : Adjacent channel interference refers to signal impairment to one frequency due to the presence of another signal on a nearby frequency.
**AM:** Amplitude Modulation (AM) uses amplitude variation in proportion to the amplitude of the modulating signal, and is usually taken as DSB-LC (Double-Sideband Large Carrier) for commercial broadcast transmissions and DSB-SC (Double-Sideband Suppressed Carrier) for multiplexed systems.

**AMC:** Adaptive Modulation and Coding (AMC) is an alternative link adaptation method in 3G mobile wireless communication. AMC provides the flexibility to match the modulation-coding scheme to the average channel conditions for each user. With AMC, the power of the transmitted signal is held constant over a frame interval, and the modulation and coding format is changed to match the current received signal quality or channel conditions.

**Analog System:** An Analog system uses an analog transmission method to send voice, video and data-using analog signals, such as electricity or sound waves, that are continuously variable rather than discreet units as in digital transmissions. Mobile analog systems include AMPS, NMT and ETACS.

**Analog Transmission:** Analog Transmission refers to signals propagated through the medium as continuously varying electromagnetic waves.

**Antenna:** Antenna is a device which radiates and/or receives radio signals, including RF, microwave, and RADAR.

**Antenna beamwidth:** Antenna beamwidth, also known as the half-power beamwidth, is the angle of an antenna pattern or beam over which the relative power is at or above 50% of the peak power.

**Antenna Directivity:** Antenna directivity, also known as antenna gain, is the relative gain of the main beam of an antenna pattern to a reference antenna, usually an isotropic or standard dipole. Antenna Directivity is the percentage of radiated signal transmitted or received in a given direction related to beamwidth.

**Antenna Efficiency:** Antenna Efficiency is the percentage of theoretical gain actually realized from an antenna.
**Antenna Gain:** Antenna gain, also known as antenna directivity, is the relative gain of the main beam of an antenna pattern to a reference antenna, usually an isotropic or standard dipole. Antenna Gain is the effectiveness of a directional antenna expressed as the ratio of input power of the directional antenna to input power of an isotropic radiator to provide the same field strength in the desired direction. Sometimes related to a dipole antenna.

**Antenna, Isotropic:** An isotropic antenna is a theoretical point source radiating a spherical power envelope.

**Antenna, Parabolic:** A parabolic antenna is an antenna utilizing a reflector that is shaped as a paraboloid in order to both concentrate the radiated signal into a beam and to provide considerable gain. Beamwidth varies inversely and gain varies directly with the size of the antenna and with frequency.

**Attenuation:** Attenuation refers to decreasing in signal magnitude between two points. These points may be along a radio path, transmission line or other devices.

**Attenuator:** Attenuator is a device specifically designed to decrease the magnitude of a signal transmitted through it.

**Average power:** Average power is the peak power averaged over time and is usually applied to pulsed systems where the carrier power is switched on and off.

**Band Pass Filter:** A Band Pass Filter is a radio wave filter with a specific range of frequencies in which it is designed to pass. It rejects frequencies outside the pass-band range. A resistor-inductor-capacitor circuit is an example of a Band Pass Filter.

**Bandwidth:** Bandwidth usually identifies the capacity of a circuit or amount of data that can be sent through a given circuit. It may be user-specified in a PVC. It is an indication of the amount of data that is passing over a medium. Also, bandwidth is the portion of the frequency spectrum required to transmit desired information. Each radio channel has a center frequency and additional frequencies above and below this carrier frequency which is used to carry the transmitted information. The range of frequencies from the lowest to the highest used is called the bandwidth.
**BER**: Bit Error Rate or Bit Error Ratio (link quality specification/testing) (BER) is a measure of transmission quality. The ratio of error bits to the total number of bits transmitted. A bit error rate of 10-6 refers to an average of one error per million bits. It is generally shown as a negative exponent, (for example, 10-7 which means 1 out of 107 bits are in error or 1 out of 10,000,000 bits are in error). Bit Error Rate is the fraction of a sequence of message bits that are in error.

**BERT**: Bit Error Rate Test/Tester (BERT) is a test that gauges the quality of the T1 or digital line. By sending a known pattern to another device across the span, the far end device can compare incoming pattern to its own, thereby indicating bit errors on the line.

**Bias Tee**: A three-port network used to supply an isolated DC signal.

**Broadband**: Broadband refers to telecommunication that provides multiple channels of data over a single communications medium, typically using some form of frequency or wave division multiplexing. It is a service or system requiring transmission channels capable of supporting rates greater than the Integrated Services Digital Network (ISDN) primary rate.

**C/I**: Carrier-to-Interference ratio (C/I) is the ratio of power in an RF carrier to the interference power in the channel.

**Carrier Frequency**: Carrier Frequency refers to the nominal frequency of a carrier wave, the frequency of the unmodulated electrical wave at the output of an amplitude modulated, the center frequency of a frequency modulation signal, frequency modulated, or phase modulated transmitter of the output of a transmitter when the modulation is zero.

**Coaxial Cable**: Coaxial Cable (Coax) is a type of electrical communications medium used in the LAN environment. This cable consists of an outer conductor concentric to an inner conductor, separated from each other by insulating material, and covered by some protective outer material. This medium offers large bandwidth, supporting high data rates with high immunity to electrical interference and a low incidence of errors. Coax is subject to distance limitations and is relatively expensive and difficult to install.

**Coupler**: A coupler is a passive device used to split or combine a transmission line.
CW : Continuous Wave (CW)

DANL : Displayed Average Noise Level (DANL): Displayed average noise level is sometimes confused with the term Sensitivity. While related, these terms have different meanings. Sensitivity is a measure of the minimum signal level that yields a defined signal-to-noise ratio (SNR) or bit error rate (BER). It is a common metric of radio receiver performance. Spectrum analyzer specifications are always given in terms of the DANL. One of the primary uses of a spectrum analyzer is to search out and measure low-level signals. The limitation in these measurements is the noise generated within the spectrum analyzer itself. This noise, generated by the random electron motion in various circuit elements, is amplified by multiple gain stages in the analyzer and appears on the display as a noise signal. On a spectrum analyzer, this noise is commonly referred to as the Displayed Average Noise Level, or DANL. While there are techniques to measure signals slightly below the DANL, this noise power ultimately limits our ability to make measurements of low-level signals.

dB : Decibel or deciBel (dB) is a unit for measuring relative power ratios in terms of gain or loss. The units of dB are expressed in terms of the logarithm to base 10 of a ratio and typically are expressed in watts. For example, a -3dB loss indicates a 50% loss in power; a +3dB reading is a doubling of power; 10 dB indicates an increase (or a loss) by a factor of 10; 20 dB indicates an increase (or a loss) of a factor of 100; 30 dB indicates an increase (or a loss) by a factor of 1000.

dBc : Decibels referenced to the carrier (dBc) is a technique for expressing a power measurement in logarithmic form using the carrier power as a reference. The units are used to describe how far down signals and noise are relative to a known signal. Typical use of this term is to describe spurious signals and noise compared to a desired transmit signal.

dBm : dBm is a decibel value referenced to a milliWatt (dBm). This is a technique for expressing a power measurement in logarithmic form using 1 mW as a reference. dBm is a decibel ratio (log 10) of Watts (W) to one milliwatt (1mW). dBm, therefore, represents absolute power.

Demodulate : To extract information from a transmitted (modulated) signal.

Demodulator : A device that extracts information from a transmitted (modulated) signal.
Deviation: The difference between signal parameters (generally in frequency modulated signals, the difference between the maximum modulated frequency and the base carrier frequency).

DHCP: Dynamic Host Configuration Protocol (DHCP)

Directional Coupler: A Directional Coupler is a device to split an incident transmission into two separate paths, and to absorb reflections from the sampled (coupled) line.

Discriminator: A Discriminator is a demodulation circuit that is used to recover the modulation from frequency modulated signals. A Discriminator responds to frequency variations.

Distributed antenna system: Distributed antenna system is a type of antenna system that is distributed or remotely located away from the transmitter. Such an antenna or series of antennas can be connected via coaxial cable, leaky feeder, or optical fiber link.

DMR: Digital Mobile Radio (DMR)

DSP: Digital Signal Processing (DSP)

Duplex: Duplex refers to two way communication.

EMF: Electromagnetic Field

Flash Memory: Flash memory is a non-volatile solid state storage device that is packaged as a chip. It can be electrically erased and reprogrammed. It is primarily used in memory cards, USB flash drives, MP3 players, and solid-state drives for general storage and transfer of data between computers and other digital products. It is a specific type of EEPROM (electrically erasable programmable read-only memory) that is erased and programmed in large blocks.

FM: Frequency Modulation (FM) is a form of angle modulation in which the instantaneous frequency of a sine-wave carrier is caused to depart from the carrier frequency by an amount proportional to the instantaneous value of the modulating wave. In FM, signals of different frequencies represent different data values.
**FM Modulation**

**Index**: In FM modulated systems, the FM Modulation Index is the ratio of the peak frequency deviation to the maximum modulating frequency. The higher the index, the greater the received quality. \( M \text{ Modulation Index} = \frac{\text{peak frequency deviation}}{\text{maximum modulation frequency}} \)

**FM Threshold**: FM Threshold is the point at which the input signal power is just strong enough to enable the receiver demodulator circuitry to successfully detect and recover a good quality television picture from the incoming video carrier.

**GPS**: The Global Positioning System (GPS) is a space-based global navigation satellite system (GNSS) that provides reliable location and time information in all weather and at all times when and where an unobstructed line of sight is available to four or more GPS satellites. The system is maintained by the United States government and is freely accessible by anyone with a GPS receiver. The Global Positioning System is making it possible for people using ground receivers to determine their geographic location within 10 to 100 meters. The satellites use simple mathematical calculations to broadcast information that is translated as longitude, latitude, and altitude by Earth-based receivers.

**Graticule**: A reticle or grid.

**IQ**: In-phase and Quadrature (IQ) or (I/Q) IQ is a method of representing digital modulation. Baseband signals can be represented by an I (In-Phase) portion and a Q (Quadrature-Phase) portion. Vectors describe the I and Q states (or equivalently the amplitude and phase) of a signal, so that all possible information about that signal can be derived from them. I text files contain pairs of I/Q values for signals that they represent. IQ modulators are 90 degrees out of phase with each other. IQ dulation combines two channels of information into one signal and then separates them later.

**LMR**: Land Mobile Radio
LTE : Long Term Evolution (LTE), sometimes also referred to as 3G LTE or Super-3G, is the 3GPP radio technology evolution architecture. Its full name is UTRA-UTRAN Long Term Evolution (LTE) and 3GPP System Architecture Evolution (SAE). TE refers to a mobile technology upgrade path for 3G networks that will provide faster data speeds and new services through new radio access technology optimized for IP-based traffic. E is part of the GSM evolutionary path beyond 3G, following EDGE, UMTS/W-CDMA, and HSPA (HSDPA and HSUPA combined). L uses Orthogonal Frequency Division Multiple Access (OFDMA) on the downlink to achieve high peak data rates in high spectrum bandwidth. LT systems will coexist with 3G systems as well as 2G systems. Mul mode devices will likely function across LTE/3G or even LTE/3G/2G, depending on market circumstances.

LVD : Low Voltage Directive (LVD)

NBFM : Narrow Band Frequency Modulation

NF : Noise Figure (NF) is a measure of degradation of the signal-to-noise ratio (SNR) that is caused by components in a radio frequency (RF) device. The noise factor (F) of a system is defined as the signal-to-noise ratio of the input power of the system divided by the signal-to-noise ratio of the output power of that system. F (the noise figure) is defined as the decibel value of the noise factor. \( F = 10 \log (F) \) where \( \log \) uses the base 10, or common log. This formula is valid only then the input termination is at standard noise temperature.

NXDN : A narrowband frequency-domain multiple access communication protocol.

OBW : Occupied Bandwidth (OBW) is a measure of the bandwidth containing 99% of the total integrated power of the transmitted spectrum, centered on the assigned channel frequency. Interference to other channels or to other systems can occur if OBW is too large.

OSL : Open Short Load

OSL : Open Short Load Through
OTA : Over The Air (OTA): OTA refers generally to any transfer of information or signal that takes place in a wireless environment, rather than using a wired connection. OTA is usually used in connection with a standard defining the provisioning of mobile devices and applications, such as downloading or uploading content or software, and commonly used in conjunction with the Short Messaging Service (SMS). SMS OTA Messages contain information that is used to configure the settings of a WAP browser in a mobile phone (refer to SMS and WAP).

P25 : An set of open interface communication standards.

PTC : Positive Train Control (PTC) is a system that provides railway safety for trains and workers. The American Railway Engineering and Maintenance-of-Way Association (AREMA) organization describes PTC as having the following primary characteristics: 1] train separation for collision avoidance, [2] enforcement of line speeds, [3] temporary speed restrictions, and safety of wayside rail workers. Ing PTC, movement authority and train location (via GPS) are available by utilizing wireless technologies.

SINAD : Signal-to-Noise And Distortion (ratio) (SINAD)

TETRA : Terrestrial Trunked Radio (TETRA) (new name)

TFT : Thin-Film Transistor/Thin-Film Technology (TFT)

TMA : A Tower Mounted Amplifier (TMA) amplifies signals from an antenna to reduce the noise figure of a base transceiver station (BTS). This helps to improve the overall sensitivity of the BTS. A TMA is a low-noise amplifier (LNA) that is usually mounted as close as practical to the antenna in Base Transceiver Stations or in mobile masts. When using a TMA, the antenna is able to receive weaker signals.

TTL : Transistor-Transistor Logic (TTL)

VSWR : Voltage Standing Wave Ratio (VSWR)
WiMax: Worldwide Interoperability for Microwave Access (WiMax), is a popular name of the 802.16 wireless metropolitan-area network standard, including both 802.16-2004 for fixed WiMAX and 802.16-2005 for mobile WiMAX. WiMax has a range of up to 31 miles. Data rates for WiMax can reach up to 75 Mbps (Fixed) or 15 Mbps (Mobile). A number of wireless signaling options exist ranging anywhere from the 2 GHz range up to 66 GHz. WiMax is primarily aimed at making broadband network access widely available without the expense of stringing wires (as in cable-access broadband) or the distance limitations of Digital Subscriber Line. WiMax technology can deliver high-speed Internet access to rural areas and other locations. WiMax also offers an alternative to satellite Internet services.
Index

A
access log . 10-12
additional documents . A-1
address
    Ethernet IP address . 6-2
administrator
    login . 10-3
    password . 10-3
annual verification . 1-8
Anritsu
    contacting . 1-2
application
    self test . 5-18
    self test submenu key . 5-4
application options
    menu . 5-5, 5-7, 5-8, 5-9
    submenu key . 5-4
auto dim . 5-16

B
banner
    show/hide . 10-12
battery
    and chargers . 2-13
    capacity . 2-1
    replacement . 1-6
    symbols . 2-13
bias tee . 8-1
black & while display setting . 2-8
black on white . 5-15
block diagram, TMA . C-1
brightness
    settings menu . 5-15, 5-16

calibration
    2 port, considerations . 3-6
    image, 2-port . 3-6
    touch screen keys . 5-4
capture
    screen . 10-7
    trace . 10-7
carrying case . 2-17
cautions
    automotive power adapter . 1-7, 2-1
    cleaning instrument . 1-5
    ESD damage . 1-6
    fan port blocking . 2-17
    test cables . 1-8
center frequency sharing . 5-12
change directory . 4-9
change file type . 4-9
charging battery . 1-7
color on white . 5-15
community activity . 10-6
connection
    LAN . 10-1
    router . 10-2
connections, identifying . 2-9
contacting Anritsu . 1-2
copy menu . 4-13
create folder . 4-10
custom language
    settings lost with reset . 5-11
data entry . 2-14
default
    display colors . 5-15
    gateway, for IP address . 6-6
delta marker setup . 3-5
DHCP
    LAN connection . 6-2
    more information . 6-6
disclaimer text . 10-13
display
    auto dim . 5-16
    brightness . 5-16
    color schemes . 5-15
    overview . 2-7
    settings . 2-8, 5-15
    submenu key . 5-11
    turn off . 5-15
distance domain . 3-6
Dynamic Host Configuration Protocol
    see DHCP
easyTest Tools . 7-4
electrostatic discharge .......................... 1-6
entering data ................................. 2-14
erasing memory ............................... 1-9
ESD damage, cautions .......................... 1-6
Ethernet
  configuration ................................ 6-4
  IP address .................................. 6-2
  menu ....................................... 6-5
external
  power connector ............................ 2-10
  power control ................................ 5-14
  reference in connector ...................... 2-11
  trigger in connector ....................... 2-11
  factory defaults
      custom language settings lost ........... 5-11
  factory defaults submenu key .............. 5-17
  fast mode .................................. 10-6
file
  management .................................. 4-2
  menu ........................................ 4-8
  setup file, recalling ....................... 4-12
  types, by extension ....................... 4-1
firmware
  updating .................................... 5-17, 5-19
floppy icon .................................... 2-14
frequency
  calibration considerations ................. 3-7
  range ....................................... 1-3
full 2-port calibration
  calibration considerations ................ 3-6
G
gateway
  default, for IP address .................... 6-6
  part of IP address .......................... 6-2
general instrument specs
  ESD damage .................................. 1-6
GPS
  antenna connector ........................... 2-11
  menu ....................................... 9-3
  option 31, main topic ....................... 9-1
  submenu key ................................ 5-4
H
headset jack .................................... 2-10
high contrast ................................... 5-15
display setting ............................... 2-8
icons
  adding and deleting ......................... 2-4
  front panel image .......................... 2-3
  front panel shortcuts ....................... 2-4
impedance submenu key ...................... 5-6
instrument name ................................ 10-9
instrument settings summary, image ....... 2-7
internal memory ................................ 1-3
invert black & while display setting ...... 2-8
IP address ..................................... 6-2, 10-1
  default gateway ............................ 6-6
  ping tool ................................... 6-8
static ......................................... 6-6
  subnet mask ................................. 6-6
ipconfig tool ................................... 6-7
I
LAN and DHCP information ..................... 6-1
LAN connection ................................. 2-10, 6-2, 10-1
language
  custom settings lost with reset ........... 5-11
  submenu key ................................ 5-11
line of sight, GPS ............................ 9-1
links
  contacting Anritsu .......................... 1-2
  product page ............................... 5-19
  S412E product page ......................... 1-2
LMR Master
  freq ranges .................................. 1-3
  overview .................................... 2-1
login .......................................... 10-3, 10-12
logout ......................................... 10-13
M
main menu key .................................. 2-6
maintenance .................................... 1-5
marker
  delta, setup .................................. 3-5
  peak and valley search ..................... 3-4
  using ....................................... 3-4
mask, subnet, for IP address ............... 6-6
master reset
  custom language settings lost ............. 5-11
  master reset submenu key ................. 5-17
Master Software Tools
  driver for Windows XP ....................... 2-10
measurement guides ........................... A-1
<table>
<thead>
<tr>
<th>Memory</th>
<th>Erasing</th>
<th>1-9</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security</td>
<td></td>
<td>1-9</td>
</tr>
<tr>
<td>Storage, Internal</td>
<td></td>
<td>1-3</td>
</tr>
<tr>
<td>USB</td>
<td></td>
<td>1-3</td>
</tr>
<tr>
<td>Menu</td>
<td>Application Options</td>
<td>5-5, 5-7, 5-8, 5-9</td>
</tr>
<tr>
<td></td>
<td>Copy</td>
<td>4-13</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>4-14</td>
</tr>
<tr>
<td></td>
<td>Display Settings</td>
<td>5-15</td>
</tr>
<tr>
<td></td>
<td>Ethernet</td>
<td>6-5</td>
</tr>
<tr>
<td></td>
<td>File</td>
<td>4-8</td>
</tr>
<tr>
<td></td>
<td>GPS</td>
<td>9-3</td>
</tr>
<tr>
<td></td>
<td>Mode Selector</td>
<td>2-16</td>
</tr>
<tr>
<td></td>
<td>Power-On</td>
<td>5-14</td>
</tr>
<tr>
<td></td>
<td>Preset</td>
<td>5-18</td>
</tr>
<tr>
<td></td>
<td>Recall</td>
<td>4-12</td>
</tr>
<tr>
<td></td>
<td>Reset</td>
<td>5-17</td>
</tr>
<tr>
<td></td>
<td>Save</td>
<td>4-9</td>
</tr>
<tr>
<td></td>
<td>Save Location</td>
<td>4-10</td>
</tr>
<tr>
<td></td>
<td>Save on Event</td>
<td>4-11</td>
</tr>
<tr>
<td></td>
<td>System</td>
<td>5-4</td>
</tr>
<tr>
<td></td>
<td>System Group</td>
<td>5-2</td>
</tr>
<tr>
<td></td>
<td>System Options</td>
<td>5-11</td>
</tr>
<tr>
<td></td>
<td>System Options 2/2</td>
<td>5-12</td>
</tr>
<tr>
<td></td>
<td>Mode Selector Menu</td>
<td>2-16</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>N</th>
<th>Name. See Instrument Name</th>
<th>10-9</th>
</tr>
</thead>
<tbody>
<tr>
<td>Night Vision</td>
<td></td>
<td>5-15</td>
</tr>
<tr>
<td>Display Setting</td>
<td></td>
<td>2-8</td>
</tr>
<tr>
<td>Normal Mode</td>
<td></td>
<td>10-6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>O</th>
<th>On via External Power</th>
<th>3-24</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option</td>
<td>10, Bias Tee</td>
<td>8-1</td>
</tr>
<tr>
<td></td>
<td>31, GPS</td>
<td>9-1</td>
</tr>
<tr>
<td>Overview of Instrument Features</td>
<td></td>
<td>2-1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>P</th>
<th>Password</th>
<th>10-3, 10-9, 10-12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Patterns, Signal Generator</td>
<td></td>
<td>5-10</td>
</tr>
<tr>
<td>Pause Mode</td>
<td></td>
<td>10-6</td>
</tr>
<tr>
<td>Peak Search Via Marker</td>
<td></td>
<td>3-4</td>
</tr>
<tr>
<td>Ping Tool</td>
<td></td>
<td>6-8</td>
</tr>
<tr>
<td>Power Control Via External Power</td>
<td></td>
<td>3-24</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>S</th>
<th>S412E Product Page (URL)</th>
<th>1-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Satellites, GPS</td>
<td></td>
<td>9-1</td>
</tr>
<tr>
<td>Save Menu</td>
<td></td>
<td>4-9</td>
</tr>
<tr>
<td>Save Setup Submenu Key</td>
<td></td>
<td>5-18</td>
</tr>
<tr>
<td>Saving Measurements</td>
<td></td>
<td>3-23</td>
</tr>
<tr>
<td>Search, Marker Value</td>
<td></td>
<td>3-4</td>
</tr>
<tr>
<td>Security of Memory</td>
<td></td>
<td>1-9</td>
</tr>
<tr>
<td>Select Files and Folders</td>
<td></td>
<td>4-13</td>
</tr>
</tbody>
</table>

| Q                 | Quick Name, Saving Files    | 4-3 |

<table>
<thead>
<tr>
<th>R</th>
<th>Recall Menu</th>
<th>4-11, 4-12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recall Setup Submenu Key</td>
<td></td>
<td>5-18</td>
</tr>
</tbody>
</table>

Remote

<table>
<thead>
<tr>
<th>Access Log</th>
<th>10-12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Display</td>
<td>10-5</td>
</tr>
<tr>
<td>Device Management</td>
<td>10-8, 10-11</td>
</tr>
<tr>
<td>Device Options</td>
<td>10-12</td>
</tr>
<tr>
<td>Instrument Name</td>
<td>10-12</td>
</tr>
<tr>
<td>Interface</td>
<td>10-3</td>
</tr>
<tr>
<td>Password</td>
<td>10-3, 10-9, 10-12</td>
</tr>
<tr>
<td>Session Time</td>
<td>10-3, 10-5, 10-10</td>
</tr>
<tr>
<td>Web Control</td>
<td>10-1</td>
</tr>
</tbody>
</table>

Replacing the Battery | 1-6 |

Reset Menu | 5-17 |

Resetting Memory | 1-9 |

RF In Connector | 2-11 |

Security of Memory | 1-9 |

Select Files and Folders | 4-13 |

Self Test

<table>
<thead>
<tr>
<th>At Start Up</th>
<th>5-18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submenu Key</td>
<td>5-4</td>
</tr>
<tr>
<td>Session Time</td>
<td>10-3, 10-5, 10-10</td>
</tr>
<tr>
<td>Set Remote Access Password Key</td>
<td>5-12</td>
</tr>
<tr>
<td>Set Up Delta Marker</td>
<td>3-5</td>
</tr>
</tbody>
</table>
T to W

setting
amplitude, SPA 3-10
BW, SPA 3-9
distance domain, VNA 3-6
cfreq, SPA 3-9, 3-14, 3-17
limit line, SPA 3-11
limit line, VNA 3-5
markers, SPA 3-12
markers, VNA 3-4
power offset, SPA 3-10, 3-15, 3-18
scale, VNA 3-4
signal standard, SPA 3-9
span, SPA 3-10
cfreq, VNA 3-4
share center freq and power offset key 5-12
signal generator patterns 5-10
single sweep 2-14
soft case 2-17
stand, tilt bail 2-18
static IP address 6-6
status submenu key 5-4
subnet 6-2, 6-6
system
display settings 5-15
menu 5-4
menu group 5-2
self test 5-18
system options menu 5-11
system options 2/2 menu 5-12
system options submenu key 5-4

T
tilt bail 2-18
TMA (Tower Mounted Amplifier) C-1
touch screen
ckeyboard 2-15
ckeys 2-6
ctrace label submenu key 5-5

U
update firmware submenu key 5-17
updating signal generator patterns 5-10
USB
cconnectors 2-10
cinterface 2-10
cmemory 1-3
cuse of phase stable Cable 1-8

V
valley search via marker 3-4
verification, annual instrument 1-8
VNA Port 1 and 2 connectors 2-11

W
warning
cexternal power connection 2-10
web links
cproduct page 5-19
cS412E product page 1-2
Web remote control 10-1
website
ccontacting Anritsu 1-2
Wi-Fi router 10-2

cconnectors 2-10
cinterface 2-10
cmemory 1-3
cuse of phase stable Cable 1-8

V
valley search via marker 3-4
verification, annual instrument 1-8
VNA Port 1 and 2 connectors 2-11

W
warning
cexternal power connection 2-10
web links
cproduct page 5-19
cS412E product page 1-2
Web remote control 10-1
website
ccontacting Anritsu 1-2
Wi-Fi router 10-2
